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Safety information

Important information
Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a "Danger" or "Warning" safety label indicates
that an electrical hazard exists which will result in personal injury if the
instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please note
Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation, and
operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.



Safety precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to this
software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION

• Do not use the software for critical control or protection applications where human or
equipment safety relies on the operation of the control action.

• Do not use the software to control time-critical functions because communication delays can
occur between the time a control is initiated and when that action is applied.

• Do not use the software to control remote equipment without securing it with an authorized
access level, and without including a status object to provide feedback about the status of the
control operation.

Failure to follow these instructions can result in death or serious injury.

WARNING
INACCURATE DATA RESULTS

• Do not incorrectly configure the software, as this can lead to inaccurate reports and/or data
results.

• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is functioning
correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of communications
links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.
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Web Applications
TheWeb Applications component provides access to several integrated applications. TheWeb
Applications interface is divided into the following sections:

Log Out | Help
In the top right corner of the screen, click Log Out to log out of the system and return to the Login
dialog. Click Help to open a list of Help files available for the applications. The logged in user name
and date display to the left of the links.

Navigation Bar
On the left side of the Navigation Bar are the following application links: Dashboards, Diagrams,
Trends, Tables, Alarms, and Reports. The system Settings link is located on right of the Navigation
Bar.

Alarm Annunciator
Above the Navigation Bar, the Alarm Annunciator shows unacknowledged alarms. User
permissions determine if the Alarm Annunciator appears. An individual count displays beside each
priority icon:

High

Medium

Low

The Alarm Annunciator also has an alarm sound option to alert you to unacknowledged alarms.
Click the speaker icon to turn the alarm sound:

On

Off

Configuration Pane
The configuration pane contains collections of data visualizations and configuration options
available for the selected application. To open the configuration pane, click < on the bar at the right
side of the framework, and click > on the bar to the right of the display pane to close it.

Display Pane
The display pane loads the data visualization selected in the configuration pane.

Application Query Parameters
By default, the first application on the Navigation Bar appears when the interface opens. To specify
which application should appear, pass the application query parameters into the web address, as
shown below:

/?application=Dashboards /?application=Tables
/?application=Diagrams /?application=Alarms
/?application=Trends /?application=Reports

WebApplications - Help Topics Web Applications
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Login
When you openWeb Applications, you are prompted to log in with your user name and password.

The access level assigned to your user name determines your access to Dashboards, Diagrams,
Tables, Trends, Alarms, Reports, and Settings. The following table indicates which of these are
excluded for each access level.

Access Level Excluded From
Observer Alarms, Alarm Annunciator, Settings
User Alarms, Alarm Annunciator, Settings
Controller Settings
Operator Settings
Supervisor None

If you do not have a user name or password, select Log in as Visitor and click Log In. Visitor
access is limited to Dashboard Slideshows.

To bypass the login page and log in as a visitor, append /visitor to the end of the web address:

http://localhost/web/visitor

If you enter an incorrect user name or password 2 times, try logging in again after approximately 10
seconds. For additional login assistance, contact your system administrator.



Settings
The Settings dialog allows you to specify system setup options and application settings. Only users
with setup privileges have access to the Settings. Click theSettings icon on theWeb
Applications Navigation Bar to open the dialog. Click Colors, Localization, Logo, orAlarms to
open their respective configuration page.

To cancel changes and close the Settings dialog at any time during setup, click Cancel or click the
X in the top right corner.

Colors
Use theColors configuration page to select a color scheme for your system. You can select from
six color schemes, or you can create your own using theCustom Color drop-down control.

When you complete your color setting, proceed to another setting configuration page, or click OK to
save your settings and close the Settings dialog.

Localization
Use the Localization configuration page to select the language, region, and date, time, and number
formats.

1. Select the system Language from the drop-down list.

2. Select theRegion from the drop-down list.

3. If you change localization settings, aSave Changes dialog opens. Click Yes to save changes.
Youmust restart the application to view localization changes.

4. When you complete your localization settings, proceed to another setting configuration page, or
click OK to save your settings and close the Settings dialog.

Logo
Use the Logo configuration page to select a custom logo for theWeb Applications user interface.

1. Click the folder icon to open anOpenwindow.

2. Navigate to and select your logo file. Themaximum file size is 2MB.

3. Click Open.

4. To remove a custom logo, click Remove to clear the entry in the Import Logo field.

5. When you complete your logo setting, proceed to another setting configuration page, or click
OK to save your settings and close the Settings dialog.

Alarms settings
The Alarms configuration page contains 2 areas, the alarm annunciator area and the event and
alarm priority classification area. Note that changes in these settings apply to all users.

Use the alarm annunciator area in the top portion of the page to specify whether or not to display the
annunciator in the user interface, and to specify when an audible notification should occur.

1. Clear theShow the Alarm Annunciator checkbox to stop displaying the Alarm Annunciator in
the user interface. The default is to show the Alarm Annunciator.

WebApplications - Help Topics Settings
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When you clear the checkbox, a note indicates that all audible alarms are disabled when the
Alarm Annunciator is not visible.

2. Select one of the following audible alarm notification options. The default option is On Low,
Medium or High Priority Alarms.

a. On Low, Medium or High Priority Alarms specifies that an audible notification occurs
for any alarm priority.

b. On Medium or High Priority Alarms specifies that an audible notification occurs for
medium or high priority alarms only.

c. OnHigh Priority Alarms specifies that an audible notification occurs for high priority
alarms only.

d. Disabled specifies that the audible notification is turned off regardless of the alarm priority.
This option also removes the audible alarm on/off icon from the Alarm Annunciator.

Use the event and alarm priority classification area in the bottom portion of the page to customize
the priority identification for alarms displayed in the Alarms application by adjusting the priority
values. By default, a priority of 192 or above is considered a High alarm, a priority of 128 to 191 is
considered aMedium alarm, and a priority of 64 to 127 is considered a Low alarm. A priority of 63 or
below is not identified as an alarm. However, these values can now be changed.

To change the values for alarm priorities:

1. Click the up or down arrow in the spin control to reset the low threshold value of 192 for high pri-
ority alarms. When youmodify this value, the high threshold value for medium priority alarms
automatically changes. For example, if you change the low threshold value from 192 to 195, the
high threshold value for medium priority alarms automatically changes from 191 to 194.

2. Click the up or down arrow in the spin control to reset the low threshold value of 128 for medium
priority alarms. When youmodify this value, the high threshold value for low priority alarms auto-
matically changes. For example, if you change the low threshold value from 128 to 130, the high
threshold value for low priority alarms automatically changes from 127 to 129.

3. Click the up or down arrow in the spin control to reset the low threshold value of 64 for low pri-
ority alarms. When youmodify this value, the high threshold value for events not identified as
alarms automatically changes. For example, if you change the low threshold value from 64 to
68, the high threshold value for events not identified as alarms automatically changes from 63 to
67.

When you complete your Alarm settings, proceed to another setting configuration page, or click OK
to save your settings and close the Settings dialog.



Dashboards
The Dashboards application provides a way to visualize present and past energy usage in
meaningful graphic representations called gadgets. These gadgets display energy data taken from
your underlying powermonitoring system, enabling you tomake informed decisions about your
operations that may impact present and future energy needs. The Dashboards application is divided
into the following sections:

View Selector
The type of view selected in the View Selector changes the display. To view a dashboard, select
Presentation View. To cycle through a slideshow collection of dashboards, select Slideshow View.
To create or edit a dashboard, select Setup View. User permissions determine access to view
types.

Configuration Pane
The configuration pane contains libraries of all the data visualizations available for the Dashboards
application. Certain libraries are displayed depending on the selected view option and user
permissions, including the Dashboard Library, Gadget Library, and Slideshow Library. To open the
configuration pane, click < on the bar at the right side of the screen, and click > on the bar to the right
of the dashboard display pane to close it.

Dashboard Display Pane
The dashboard display pane shows the dashboard selected in the Dashboard Library. By default, a
dashboard is displayed the first time you sign in to the system. This dashboard is assigned by the
system administrator as the Systemwide Homepage. All user security levels, except observers,
can select a new default homepage by selectingUse this Dashboard as my Homepage in the
Dashboard Properties Window.

Presentation View
Presentation View enables you to select and display dashboards and slideshows. Presentation
View consists of the Dashboard Library where you can select and view pre-configured dashboards,
the Slideshow Library where you can select a slideshow for display in Slideshow View, and the
dashboard display pane where the selected dashboard and associated gadgets display. User
permissions determine which of the following options are available.

Dashboard Library
The Dashboard Library contains a library of all dashboards available in the system.

Click the following Dashboard Library icon to:

Open the Dashboard Properties window and select Use this Dashboard as
my Homepage to make the selected dashboard the default. Your default
dashboard appears as the homepage in the dashboard display pane when you
log into the system.

WebApplications - Help Topics Dashboards
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Slideshow Library
The Slideshow Library contains a library of all slideshows available in the system. The Slideshow
Library appears as thePublic Dashboard Library for users logged in as Visitor. To reorder
dashboards in a slideshow, select a dashboard title, then drag and place it where you want it to
appear in the slideshow.

To display a slideshow in the application full screenmode, log in as a Visitor and follow the steps
below.

To display a slideshow:

1. Click Slideshow View. The Slideshow Settings window appears.

2. Select a slideshow from the drop-down list.

3. Drag and place the slideshow interval selector to set the slideshow interval. The slideshow inter-
val options range from 10 to 300 seconds.

4. Click OK to save the selected slideshow interval and begin to display the slideshow in
Slideshow View, or click Cancel or theX in the top right corner to close the Slideshow Settings
window and return to Setup View.

5. To change the display to browser full screenmode, press F11.

To exit a slideshow, select another View (Presentation or Setup), or click Esc. if the slideshow is in
Full Screenmode.

Dashboard Display Pane
In Presentation View, the gadgets associated with the selected dashboard cannot be configured
from the dashboard display pane.

Slideshow View
If slideshows have been configured, Slideshow View enables you to display pre-configured
slideshows at various locations throughout a facility, or through a web-browser on a company
intranet. Configure slideshows using the Slideshow Library in Setup View.

To display a slideshow in application full screenmode, log in as a Visitor and follow the steps below.

To display a slideshow:

1. Click Slideshow View. The Slideshow Settings window appears.

2. Select a slideshow from the drop-down list.

3. Drag and place the slideshow interval selector to set the slideshow interval. The slideshow inter-
val options range from 10 to 300 seconds.

4. Click OK to save the selected slideshow interval and begin to display the slideshow in
Slideshow View, or click Cancel or theX in the top right corner to close the Slideshow Settings
window and return to Setup View.

5. To change the display to browser full screenmode, press F11.

To exit a slideshow, select another View (Presentation or Setup), or click Esc. if the slideshow is in
application full screenmode.



Setup View
Setup View allows you to create and fully configure dashboards, gadgets, and slideshows. Setup
View consists of the Dashboard Library where you can create and configure dashboards, the
Gadget Library containing all available gadgets, the Slideshow Library where you can create and
configure slideshows, and the dashboard display pane where the selected dashboard and
associated gadgets appear. User permissions determine which of the following options are
available to you.

Dashboard Library
The Dashboard Library contains all the dashboards available in the system.

Click the following Dashboard Library icons to:

Add a new dashboard.
Organize your dashboards:
1. A new folder opens in the Dashboard Library.

2. Click to open the folder properties window.
3. Enter a name and description for the folder, then click OK.
4. To add an existing dashboard to the folder, select the dashboard, then drag
and drop it in the folder.
5. To add or delete dashboards in the folder, click the appropriate icons.

6. To add a sub-folder, click and follow Steps 1 to 4.
Open the Dashboard Properties window and configure the settings for the
selected dashboard.
Delete the selected dashboard. The Confirm dialog box appears. Click Yes to
delete the dashboard orNo to return to the Dashboard Library.

Gadget Library
TheGadget Library contains all the gadgets available in the system. Type in the search tool to find
gadget types or titles in the Gadget Library. You can also sort the gadgets by the following types:
All, Energy,Web, orGeneral.

To add a gadget to a dashboard, select the gadget, then drag and drop it on an open area of the
dashboard displayed in the dashboard display pane. The gadget type andClick to Setupwill
appear. Setup varies by gadget type.

Slideshow Library
The Slideshow Library contains a library of all slideshows available in the system. To reorder
dashboards in a slideshow, select a dashboard title, then drag and place it where you want it to
appear in the list.

Click the following Slideshow Library icons to:

Add a new slideshow.
Open the Slideshow Properties window and enter a name and description for
the selected slideshow.
Delete the selected slideshow. The Confirm dialog box appears. Click Yes to
delete the slideshow orNo to return to the Slideshow Library.

WebApplications - Help Topics Dashboards
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To build a slideshow:

1. In Setup View, select the slideshow you want to build from the drop-down list.

2. Select a dashboard from the Dashboard Library, then drag and drop it in the selected slideshow.

3. Repeat Step 2 to add additional dashboards. You can add up to 100 dashboards to a slideshow.

Changes to existing slideshows must bemanually updated. Reload the updated slideshow on
remote kiosks and displays to show themost current information.

To display a slideshow in application full screenmode, log in as a Visitor and follow the steps below.

To display a slideshow:

1. Click Slideshow View. The Slideshow Settings window appears.

2. Select a slideshow from the drop-down list.

3. Drag and place the slideshow interval selector to set the slideshow interval. The slideshow inter-
val options range from 10 to 300 seconds.

4. Click OK to save the selected slideshow interval and begin to display the slideshow in
Slideshow View, or click Cancel or theX in the top right corner to close the Slideshow Settings
window and return to Setup View.

5. To change the display to browser full screenmode, press F11.

To exit a slideshow, select another View (Presentation or Setup), or click Esc. if the slideshow is in
Full Screenmode.

Slideshow Query Parameters

To limit the Slideshow Library to only 1 slideshow, pass the following query parameter into the web
address:

/?slideshow= (Slideshow Name)

If the slideshow name contains spaces then the spaces should be substituted with%20. For
example, for a slideshow namedMy Slideshow:

/?slideshow=My%20Slideshow

Dashboard Display Pane
In Setup View, the gadgets associated with the selected dashboard can be configured from the
dashboard display pane.

Dashboard Library
The Dashboard Library contains all the dashboards available in the system. User permissions and
view type determine which of the following options are available.

Dashboard Library Icons
Click the following Dashboard Library icons to:

Add a new dashboard.



Organize your dashboards:
1. A new folder opens in the Dashboard Library.

2. Click to open the folder Properties window.
3. Enter a name and description for the folder, then click OK.
4. To add an existing dashboard to the folder, select the dashboard, then drag
and drop it in the folder.
5. To add or delete dashboards in the folder, click the appropriate icons.

6. To add a sub-folder, click and follow Steps 1 to 5.
Open the Dashboard Properties window and configure the settings for the
selected dashboard.
Delete the selected dashboard. The Confirm dialog box appears. Click Yes to
delete the dashboard orNo to return to the Dashboard Library.

Dashboard Properties Window
The Dashboard Properties window opens to the General screen. Use the left navigation pane to
configure the properties in the General, Layout, Background, andMy Settings screens. User
permissions determine which of the following options are available.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

General

1. Enter aName for the dashboard. The name is displayed in the list of dashboards in the Dash-
board Library.

2. Enter aDescription of the dashboard in the area provided.

3. To use the selected dashboard as theSystemwide Homepage, select the check box. Once
defined, the system default homepage cannot be deleted.

4. Proceed to the next section, or click OK to save your settings and close the Dashboard Prop-
erties window.

Layout

1. Select Layout on the left navigation pane.

2. Select the tab for the number of gadgets you want to place on the dashboard.

3. Select a layout option. Theremay bemore than one layout option for the number tab you select.

4. Proceed to the next section, or click OK to save your settings and close the Dashboard Prop-
erties window.

Background

1. Select Background on the left navigation pane.

2. To upload a file to theBackgroundImages folder on the server, click Add Image, navigate to
and select the image, then click Open. Themaximum file size is 2MB.

3. To set a background image for the dashboards display pane, select an image in the background
images selector. The opacity selector and a thumbnail of the image appears.

WebApplications - Help Topics Dashboards
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4. Set the opacity. As you select an opacity option, the thumbnail window provides a preview.

5. To deselect an image, click Clear, and refer to the previous steps to set a new image. If you do
not select an image, the dashboards display pane background will remain blank.

6. Proceed to the next section, or click OK to save your settings and close the Dashboard Prop-
erties window.

My Settings

1. SelectMy Settings on the left navigation pane.

2. Select Use this Dashboard as my Homepage to make the current dashboard the default that
appears in the dashboard display pane when you log into the system.

3. Click OK to save your settings and close the Dashboard Properties window.

Gadget Library
Gadgets are graphical display objects used in the dashboard display pane to represent
measurements or key performance indicators (KPIs). TheGadget Library contains all the gadgets
available in the system. It is only displayed in Setup View.

Type in the search field to find specific gadget types or titles in the gadget library. You can also sort
the gadgets by the following types: All, Energy,Web, orGeneral.

To add a gadget to a dashboard, select the gadget, then drag and drop it on an open area of the
dashboard displayed in the dashboard display pane. The gadget type andClick to Setupwill
appear. Setup varies by gadget type.

Bar/Line Gadget
The Bar/Line gadget displays energy consumption from several data series in a single chart that
allows you to compare consumption with outside drivers. You can set either the bar or line as the
primary axis chart.

To set or view the Bar/Line gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:

Move the gadget to another position on the dashboard.
Open the Bar/Line Gadget Setup window and configure the gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.



Bar/Line Gadget Setup
The Bar/Line gadget properties dialog opens to the Summary page. Click Summary, Charts
Available, Data Series, orViewing Period in the navigation pane to open their respective
properties configuration page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section in the left navigation pane, or click OK to save your settings and
view the configured gadget on the dashboard.

Chart Type

1. Select Chart Type on the left navigation pane.

2. On the Primary Axis tab, select the bar chart or line chart radio button for the primary axis, then
select either the other chart type or None for the Secondary Axis tab.

3. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Data Series

There are two options for selecting a data series for a gadget; Devices andViews. Selecting the
sources by device allows you to pick a source from a list of devices connected to PowerMonitoring
Expert. Selecting by view allows you to pick sources based on the views configured in a hierarchy,
such as a floor in a physical layout or a circuit in an electrical view, or, by virtual meters defined in
Hierarchy Manager. For additional information regarding hierarchies and virtual meters, see
Hierarchy Manager help.

Data series by device

To select your data series by device:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Devices in theSources area.

4. Select an option from theGrouping drop-down list. Select None for no grouping, orDevice
Groups, which organizes the devices based on groups defined inManagement Console. See
"Management Console" in theStruxureWare PowerMonitoring Expert User Guide for additional
information.

WebApplications - Help Topics Dashboards
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5. Select a source from the device list.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. TheDisplay only Measurements with data option allows you to see only themeasurements
that contain data. Uncheck this option to show all measurements, regardless of whether the
measurements contain data or not.

9. Click to view newly added devices or measurements.

10. Click the arrow beside any measurement heading in the list to expand it to display themeas-
urement types. Select themeasurement you want to display in the gadget.

11. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

12. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001

13. Click OK to return to theData Series tab.

14. Click Add to add another data series to the Chart. You can chart up to 8 data series.

15. Tomodify an existing data series, select a series from the list and click Edit .

16. To remove a series from the list, select a series from the list and click Delete .

17. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Data series by view
To select your data series by view:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Views in theSources area.

This allows you to select:

A view as defined in the hierarchy, such as a physical layout made up of buildings, floors and
rooms, or a data center with tenants, racks, and circuits.



A virtual meter that is defined in Hierarchy Manager.

4. Select an option from theViews drop-down list. Changing the view provides alternative ways of
showing hierarchy relationships between the different Nodes or by showing virtual meters. For
information regarding hierarchies and virtual meters, see Hierarchy Manager help.

5. Select a Node from a hierarchy view or a virtual meter from theVirtual Meter view.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. Click to view newly added devices or measurements.

9. Select themeasurement to display in the gadget.

10. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

11. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001.

12. Click OK to return to theData Series tab.

13. Click Add to add another data series to the Chart. You can chart up to 8 data series.

14. Tomodify an existing data series, select a series from the list and click Edit .

15. To remove a series from the list, select a series from the list and click Delete .

16. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. For viewing periods that havemore than one viewing interval available, select the applicable
viewing interval option.

4. Click OK to save your settings and view the configured gadget on the dashboard.

Energy Equivalency Gadget
The Energy Equivalency gadget aggregates energy consumption from one or more data sources for
the specified time range into a single value, convertingmeasurement units as needed.

To set or view the Energy Equivalency gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:
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Move the gadget to another position on the dashboard.
Open the Energy Equivalency Gadget Setup window and configure the
gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.

Energy Equivalency Gadget Setup
The Energy Equivalency gadget properties dialog opens to the Summary page. Click Summary,
Settings,Measurements, Image, andViewing Period in the navigation pane to open their
respective properties configuration page.

Summary

1. Enter a Title for the gadget. The title is not currently displayed but may be in the future.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section in the left navigation pane, or click OK to save your settings and
view the configured gadget on the dashboard.

Settings

1. Select Settings on the left navigation pane.

2. Enter theEnergy Equivalency Description to be displayed in the gadget.

3. Enter theValue Multiplier value to convert from the watt-hour values into the equivalent meas-
urement.

4. Enter theValue Unit for the equivalency. For example, "miles", "kilometers", "lbs", "kg", and
so on.

5. Select theValue Unit Placement to be placed either before or after the actual value.

6. Select theDecimal Places to Display in the value.

7. Select an item from thePredefined Energy Equivalencies list if you want to apply predefined
values for common equivalencies to the fields on the page.

8. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Measurements

Add one or more source-measurements to use for gathering the data. Themeasurements are
organized on tabs for ease of identification. After selecting the tab and clickingAdd, use the next
window to select the Source andMeasurement. TheMultiplier value is the constant multiplier that



needs to be applied to the value to convert it to a watt-hour value. This value is automatically
populated for several well-knownmeasurements. Press OK when you have complete the entries on
this window.

Image

1. Select Image on the left navigation pane.

2. Select an image to display on the gadget by selected it from the displayed list. You can add a
custom image by pressing theAdd Image button and selecting an image to upload.

3. If you do not want an image to be displayed, press theClear button

4. Proceed to the next section in the left navigation pane, or click OK to save your settings and
view the configured gadget on the dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. Click OK to save your settings and view the configured gadget on the dashboard.

Horizontal Bar Gadget
The Horizontal Bar gadget displays a summary comparison of several data series in a single chart
that allows you to compare consumption.

To set or view the Horizontal Bar gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:

Move the gadget to another position on the dashboard.
Open the Horizontal Bar Gadget Setup window and configure the gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.

Horizontal Bar Gadget Setup
The Horizontal Bar gadget properties dialog opens to the Summary page. Click Summary, Data
Series, orViewing Period in the navigation pane to open their respective properties configuration
page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.
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Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Data Series

There are two options for selecting a data series for a gadget; Devices andViews. Selecting the
sources by device allows you to pick a source from a list of devices connected to PowerMonitoring
Expert. Selecting by view allows you to pick sources based on the views configured in a hierarchy,
such as a floor in a physical layout or a circuit in an electrical view, or, by virtual meters defined in
Hierarchy Manager. For additional information regarding hierarchies and virtual meters, see
Hierarchy Manager help.

Data series by device

To select your data series by device:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Devices in theSources area.

4. Select an option from theGrouping drop-down list. Select None for no grouping, orDevice
Groups, which organizes the devices based on groups defined inManagement Console. See
"Management Console" in theStruxureWare PowerMonitoring Expert User Guide for additional
information.

5. Select a source from the device list.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. TheDisplay only Measurements with data option allows you to see only themeasurements
that contain data. Uncheck this option to show all measurements, regardless of whether the
measurements contain data or not.

9. Click to view newly added devices or measurements.



10. Click the arrow beside any measurement heading in the list to expand it to display themeas-
urement types. Select themeasurement you want to display in the gadget.

11. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

12. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001

13. Click OK to return to theData Series tab.

14. Click Add to add another data series to the Chart. You can chart up to 8 data series.

15. Tomodify an existing data series, select a series from the list and click Edit .

16. To remove a series from the list, select a series from the list and click Delete .

17. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Data series by view
To select your data series by view:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Views in theSources area.

This allows you to select:

A view as defined in the hierarchy, such as a physical layout made up of buildings, floors and
rooms, or a data center with tenants, racks, and circuits.

A virtual meter that is defined in Hierarchy Manager.

4. Select an option from theViews drop-down list. Changing the view provides alternative ways of
showing hierarchy relationships between the different Nodes or by showing virtual meters. For
information regarding hierarchies and virtual meters, see Hierarchy Manager help.

5. Select a Node from a hierarchy view or a virtual meter from theVirtual Meter view.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.
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8. Click to view newly added devices or measurements.

9. Select themeasurement to display in the gadget.

10. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

11. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001.

12. Click OK to return to theData Series tab.

13. Click Add to add another data series to the Chart. You can chart up to 8 data series.

14. Tomodify an existing data series, select a series from the list and click Edit .

15. To remove a series from the list, select a series from the list and click Delete .

16. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. For viewing periods that havemore than one viewing interval available, select the applicable
viewing interval option.

4. Click OK to save your settings and view the configured gadget on the dashboard.

Period over Period Gadget
The Period over Period gadget displays consumption from two defined viewing periods that allow
you to identify patterns in consumption.

To set or view the Period over Period gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:

Move the gadget to another position on the dashboard.
Open the Period over Period Gadget Setup window and configure the
gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.



Period over Period Gadget Setup
The Period over Period gadget properties dialog opens to the Summary page. Click Summary, Data
Series, orViewing Period in the navigation pane to open their respective properties configuration
page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Data Series

There are two options for selecting a data series for a gadget; Devices andViews. Selecting the
sources by device allows you to pick a source from a list of devices connected to PowerMonitoring
Expert. Selecting by view allows you to pick sources based on the views configured in a hierarchy,
such as a floor in a physical layout or a circuit in an electrical view, or, by virtual meters defined in
Hierarchy Manager. For additional information regarding hierarchies and virtual meters, see
Hierarchy Manager help.

Data series by device

To select your data series by device:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Devices in theSources area.

4. Select an option from theGrouping drop-down list. Select None for no grouping, orDevice
Groups, which organizes the devices based on groups defined inManagement Console. See
"Management Console" in theStruxureWare PowerMonitoring Expert User Guide for additional
information.

5. Select a source from the device list.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.
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Consumption Measurements displays measurements related to consumption.

8. TheDisplay only Measurements with data option allows you to see only themeasurements
that contain data. Uncheck this option to show all measurements, regardless of whether the
measurements contain data or not.

9. Click to view newly added devices or measurements.

10. Click the arrow beside any measurement heading in the list to expand it to display themeas-
urement types. Select themeasurement you want to display in the gadget.

11. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

12. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001

13. Click OK to return to theData Series tab.

14. Click Add to add another data series to the Chart. You can chart up to 8 data series.

15. Tomodify an existing data series, select a series from the list and click Edit .

16. To remove a series from the list, select a series from the list and click Delete .

17. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Data series by view
To select your data series by view:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Views in theSources area.

This allows you to select:

A view as defined in the hierarchy, such as a physical layout made up of buildings, floors and
rooms, or a data center with tenants, racks, and circuits.

A virtual meter that is defined in Hierarchy Manager.

4. Select an option from theViews drop-down list. Changing the view provides alternative ways of
showing hierarchy relationships between the different Nodes or by showing virtual meters. For
information regarding hierarchies and virtual meters, see Hierarchy Manager help.

5. Select a Node from a hierarchy view or a virtual meter from theVirtual Meter view.

6. Select an option from the Type drop-down list.



7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. Click to view newly added devices or measurements.

9. Select themeasurement to display in the gadget.

10. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

11. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001.

12. Click OK to return to theData Series tab.

13. Click Add to add another data series to the Chart. You can chart up to 8 data series.

14. Tomodify an existing data series, select a series from the list and click Edit .

15. To remove a series from the list, select a series from the list and click Delete .

16. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. For viewing periods that havemore than one viewing interval available, select the applicable
viewing interval option.

4. Click OK to save your settings and view the configured gadget on the dashboard.

Pie Gadget
The Pie gadget displays a summary comparison of several data series in a single chart that allows
you to determine the relationship between several sources of consumption.

To set or view the Pie gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:

Move the gadget to another position on the dashboard.
Open the Pie Gadget Setup window and configure the gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help
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Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.

Pie Gadget Setup
The Pie gadget properties dialog opens to the Summary page. Click Summary, Data Series, or
Viewing Period in the navigation pane to open their respective properties configuration page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Data Series

There are two options for selecting a data series for a gadget; Devices andViews. Selecting the
sources by device allows you to pick a source from a list of devices connected to PowerMonitoring
Expert. Selecting by view allows you to pick sources based on the views configured in a hierarchy,
such as a floor in a physical layout or a circuit in an electrical view, or, by virtual meters defined in
Hierarchy Manager. For additional information regarding hierarchies and virtual meters, see
Hierarchy Manager help.

Data series by device

To select your data series by device:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Devices in theSources area.

4. Select an option from theGrouping drop-down list. Select None for no grouping, orDevice
Groups, which organizes the devices based on groups defined inManagement Console. See
"Management Console" in theStruxureWare PowerMonitoring Expert User Guide for additional
information.

5. Select a source from the device list.

6. Select an option from the Type drop-down list.



7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. TheDisplay only Measurements with data option allows you to see only themeasurements
that contain data. Uncheck this option to show all measurements, regardless of whether the
measurements contain data or not.

9. Click to view newly added devices or measurements.

10. Click the arrow beside any measurement heading in the list to expand it to display themeas-
urement types. Select themeasurement you want to display in the gadget.

11. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

12. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001

13. Click OK to return to theData Series tab.

14. Click Add to add another data series to the Chart. You can chart up to 8 data series.

15. Tomodify an existing data series, select a series from the list and click Edit .

16. To remove a series from the list, select a series from the list and click Delete .

17. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Data series by view
To select your data series by view:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Views in theSources area.

This allows you to select:

A view as defined in the hierarchy, such as a physical layout made up of buildings, floors and
rooms, or a data center with tenants, racks, and circuits.

A virtual meter that is defined in Hierarchy Manager.
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4. Select an option from theViews drop-down list. Changing the view provides alternative ways of
showing hierarchy relationships between the different Nodes or by showing virtual meters. For
information regarding hierarchies and virtual meters, see Hierarchy Manager help.

5. Select a Node from a hierarchy view or a virtual meter from theVirtual Meter view.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. Click to view newly added devices or measurements.

9. Select themeasurement to display in the gadget.

10. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

11. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001.

12. Click OK to return to theData Series tab.

13. Click Add to add another data series to the Chart. You can chart up to 8 data series.

14. Tomodify an existing data series, select a series from the list and click Edit .

15. To remove a series from the list, select a series from the list and click Delete .

16. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. For viewing periods that havemore than one viewing interval available, select the applicable
viewing interval option.

4. Click OK to save your settings and view the configured gadget on the dashboard.

Trending Gadget
The Trending gadget displays the trends of several topics in a data series over any query time
period.

To set or view the Trending gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:



Move the gadget to another position on the dashboard.
Open the Trending Gadget Setup window and configure the gadget.
Change the viewing period. Once a gadget has been defined, click the
arrow to open a list of alternate viewing options available for selection.

Display the Gadget Setup Help

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the
gadget orNo to return to the dashboard display pane.

Trending Gadget Setup
The Trending gadget properties dialog opens to the Summary page. Click Summary, Data Series,
orViewing Period in the navigation pane to open their respective properties configuration page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Data Series

There are two options for selecting a data series for a gadget; Devices andViews. Selecting the
sources by device allows you to pick a source from a list of devices connected to PowerMonitoring
Expert. Selecting by view allows you to pick sources based on the views configured in a hierarchy,
such as a floor in a physical layout or a circuit in an electrical view, or, by virtual meters defined in
Hierarchy Manager. For additional information regarding hierarchies and virtual meters, see
Hierarchy Manager help.

Data series by device

To select your data series by device:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Devices in theSources area.
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4. Select an option from theGrouping drop-down list. Select None for no grouping, orDevice
Groups, which organizes the devices based on groups defined inManagement Console. See
"Management Console" in theStruxureWare PowerMonitoring Expert User Guide for additional
information.

5. Select a source from the device list.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. TheDisplay only Measurements with data option allows you to see only themeasurements
that contain data. Uncheck this option to show all measurements, regardless of whether the
measurements contain data or not.

9. Click to view newly added devices or measurements.

10. Click the arrow beside any measurement heading in the list to expand it to display themeas-
urement types. Select themeasurement you want to display in the gadget.

11. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

12. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001

13. Click OK to return to theData Series tab.

14. Click Add to add another data series to the Chart. You can chart up to 8 data series.

15. Tomodify an existing data series, select a series from the list and click Edit .

16. To remove a series from the list, select a series from the list and click Delete .

17. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Data series by view
To select your data series by view:

1. Select Data Series from the left navigation.

Measurement Units for thePrimary Axis Label and theSecondary Axis Label is selected
by default.Measurement Units uses the units of the data selected in theData Series tab.

To specify a different label for the axis, select Custom and enter a description in theCustom
field.

2. Click Add to add a data series. The data series selector dialog opens.

3. Select Views in theSources area.



This allows you to select:

A view as defined in the hierarchy, such as a physical layout made up of buildings, floors and
rooms, or a data center with tenants, racks, and circuits.

A virtual meter that is defined in Hierarchy Manager.

4. Select an option from theViews drop-down list. Changing the view provides alternative ways of
showing hierarchy relationships between the different Nodes or by showing virtual meters. For
information regarding hierarchies and virtual meters, see Hierarchy Manager help.

5. Select a Node from a hierarchy view or a virtual meter from theVirtual Meter view.

6. Select an option from the Type drop-down list.

7. Select an option from theShow drop-down list. You can choose to show only measurements
based on the following categories:

All Measurements displays all available measurements for the selected utility type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays measurements related to consumption.

8. Click to view newly added devices or measurements.

9. Select themeasurement to display in the gadget.

10. Type a description in theDisplay Name field to add or change the data series display name for
the gadget.

11. Change themultiplier value by entering the new value in theMultiplier field (optional).

Change themultiplier value to convert the data from its original measurement unit to the display
unit. For example, convert themeasurement unit from kWh toMWh by using amultiplier of
0.001.

12. Click OK to return to theData Series tab.

13. Click Add to add another data series to the Chart. You can chart up to 8 data series.

14. Tomodify an existing data series, select a series from the list and click Edit .

15. To remove a series from the list, select a series from the list and click Delete .

16. Proceed to another tab, or click OK to save your settings and view the configured gadget on the
dashboard.

Viewing Period

1. Select Viewing Period on the left navigation pane.

2. Select a viewing period from the drop-down list.

3. For viewing periods that havemore than one viewing interval available, select the applicable
viewing interval option.

4. Click OK to save your settings and view the configured gadget on the dashboard.
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Web Image Gadget
TheWeb Image gadget displays a static image of a website. You can configure the gadget to
display a specified area of the website, and to take a new snapshot at a defined interval.

To set or view theWeb Image gadget properties for the first time, click Click to Set Up.

Move your pointer to the top of the gadget to display the gadget icons. Use the gadget icons to:

Move the gadget to another position on the dashboard.
Open theWeb ImageGadget Setup window and configure the gadget.

Display the Gadget Setup help.

Restore the gadget to the original size and position as defined in the Layout
screen of the Dashboard Properties window.
Maximize the gadget to fill the dashboard.
Delete the gadget. The Confirm dialog opens. Click Yes to delete the gadget or
No to return to the dashboard display pane.

Web Image Gadget Setup
TheWeb Image gadget properties dialog opens to the Summary page. Click Summary orSelected
URL in the navigation pane to open their respective properties configuration page.

To cancel changes and close the gadget setup window at any time during setup, click Cancel or
click theX in the top right corner.

Summary

1. Enter a Title for the gadget. The title is displayed on the front of the gadget.

2. Enter aDescription of the gadget in the area provided.

3. Change theGadget Opacity to allow the background image to be visible through the gadget.

4. Proceed to the next section, or click OK to save your settings and view the configured gadget
on the dashboard.

Selected URL

1. TheWeb Image gadget displays a static image of a website. Enter theURL for the website you
want to display. For security purposes, the URLmust use only the http or https protocol.

2. Click Preview to see the website in the preview window.

3. To set a delay between the time when the website loads and the snapshot is taken, enter a
Loading Wait Time value (in seconds) between 0 and 300. For example, 3 to 6 seconds is
recommended for aWebReach page to allow the content to load.

4. To define when a new snapshot of the website is taken, enter aRefresh Interval value (in
seconds) between 3 and 86,400.

5. To display the website as it displays in the preview window, leave the Image Width and
Height default values.
To display more or less of the website, adjust theWidth orHeight value, then click Preview. If
you change an Image value, the other value adjusts automatically to maintain proportion.



6. To display amanually cropped region of the website, click on the image and draw the crop
region. The preview window refreshes automatically.
Tomodify theCrop rectangle, adjust the Left, Top,Width, andHeight crop values as
needed, then click Preview.

7. To set a new crop region, click Clear Crop to return to the original image, and repeat Step 6.

8. Click OK to save your settings and view the configured gadget on the dashboard.

Where Is My Measurement?
If you do not see ameasurement that you expect in the data series list, it is probably due to one of
the following:

l Themeasurement is not logged. By default, only loggedmeasurements are available in the data
series list. To view newly addedmeasurements, unselect Display only Measurements with
Data.

l Themeasurement is filtered out of the current list. Select from one of the options in theShow
drop-down list:

All Measurements displays all available measurements for the selected type.

Common Measurements displays a list of themost commonly usedmeasurements.

Consumption Measurements displays only measurements related to consumption.

l Themeasurement is not available for the type selected in the Type drop-down list. Select a dif-
ferent type from the Type drop-down list.

l Themeasurement is a custommeasurement for which themetadata is not set up. Themetadata
defines themeasurement type, as well as how ameasurement is presented in the Type and
Show drop-down lists. The standardmeasurements supplied in the software have their
metadata already defined. However, metadata for an application-specific measurement created
in the field (i.e. a custommeasurement) must also be defined in order for the software to know
how to use themeasurement.

Slideshow Library
The Slideshow Library contains all the slideshows available in the system. To reorder dashboards in
a slideshow, select a dashboard title, then drag and place it where you want it to appear in the list.
The Slideshow Library appears as thePublic Dashboard Library for users logged in as Visitors.
User permissions and view type determine which of the following options are available.

Click the following Slideshow Library icons to:

Add a new slideshow. The new slideshow appears in the drop-down list.
Open the Slideshow Properties window and enter a name and description for
the selected slideshow.
Delete the selected slideshow. The Confirm dialog box appears. Click Yes to
delete the slideshow orNo to return to the Slideshow Library.

To build a slideshow:
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1. In Setup View, select the slideshow you want to build from the drop-down list.

2. Select a dashboard from the Dashboard Library, then drag and drop it in the selected slideshow.

3. Repeat Step 2 to add additional dashboards. You can add up to 100 dashboards to a slideshow.

Changes to existing slideshows must bemanually updated. Reload the updated slideshow on
remote kiosks and displays to show themost current information.

To display a slideshow in the application full screenmode, log in as a Visitor and follow the steps
below.

To display a slideshow:

1. Click Slideshow View. The Slideshow Settings window appears.

2. Select a slideshow from the drop-down list.

3. Drag and place the slideshow interval selector to set the slideshow interval. The slideshow inter-
val options range from 10 to 300 seconds.

4. Click OK to save the selected slideshow interval and begin to display the selected slideshow,
or click Cancel or theX in the top right corner to close the Slideshow Settings window and
return to Setup View.

5. To change the display to browser full screenmode, press F11.

To exit a slideshow, select another View (Presentation or Setup), or click Esc. if the slideshow is in
application full screenmode.

Slideshow Query Parameters
To limit the Slideshow Library to only 1 slideshow, pass the following query parameter into the web
address:

/?slideshow= (Slideshow Name)

If the slideshow name contains spaces then the spaces should be substituted with%20. For
example, for a slideshow namedMy Slideshow:

/?slideshow=My%20Slideshow

To bypass the login page and automatically launch a slideshow, append /visitor to the query
parameter in the web address:

/visitor/?slideshow= (Slideshow Name)

Slideshow Properties Window
The Slideshow Properties window opens to the General screen. Enter the slideshow Name and
Description.

To view the configured slideshow:

1. Click OK to save the slideshow settings and close the Slideshow Properties window.

2. Click Slideshow View. The Slideshow Settings window appears.

3. Select a slideshow from the drop-down list.



4. Drag and place the slideshow interval selector to set the slideshow interval. The slideshow inter-
val options range from 10 to 300 seconds.

5. Click OK to save the selected slideshow interval and begin to display the slideshow, or click
Cancel or theX in the top right corner to close the Slideshow Settings window and return to
Setup View.

6. To change the display to browser full screenmode, press F11.

To display a slideshow in application full screenmode, log in as a Visitor and follow the steps
above.

To exit a slideshow, select another View (Presentation or Setup), or click Esc. if the slideshow is in
application full screenmode.
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Diagrams
The Diagrams application allows users to access and display Vista diagrams in theWeb
Applications (browser) interface. The Diagrams applicationmanages all the necessary data
processing and system functions at the server and uses XML to process Vista objects and data for
display on theWeb pages.

Use theWeb Applications component from any computer on your network to view the Vista network
diagrams of devices in your powermanagement system. Objects that can be displayed in the
browser include real-time numeric data, full or partial gauges, background graphics or diagrams, and
basic views of event, data and waveform logs.

Although identical in many ways to Vista, the Diagrams application has certain differences and
limitations:

l The diagrams are read-only; control objects such as On/Off and Trigger switches are disabled.

l The time displayed is the local time at theWeb server, not at the client computer.

NOTE: Configure the TZ Offset, DST Start, DST End, and DST Offset on themeter to display the
correct local time in the Diagrams application.

The Diagrams application and user authentication
User authentication for the Diagrams application is enabled by default. It is also enabled if you
upgrade from previous versions of the product.

If you access Diagrams from a browser on aWebClient computer using the URL
http://server_name/ion (where server_name is the fully-qualified name of the server or its
IP address), you are prompted to log in using your PowerMonitoring Expert user name and
password.

If you access the Diagrams application on the server which hosts the IIS service, user
authentication is not required. This also applies for any http request originating from applications
within the server hosting the IIS service. For example, if aWeb Image gadget in the Dashboards
application is configured to access Diagrams, user authentication is not required.

Contact your Schneider Electric representative if you want to disable user authentication for
Diagrams.

Preliminary setup
Before you can view Vista diagrams in the Diagrams application, a network diagram
(“network.dgm”) must exist. The Diagrams application processes each element in the network
diagram and converts them for display in the browser.

Note that the Vista component is installed with PowerMonitoring Expert on a primary server or
Engineering Client. Contact your system administrator if you need a network diagram generated for
your use or if you need access to Vista.

To generate a network diagram automatically in Vista:

1. Start Vista.

2. Click File > Generate network diagram.

3. Click File > Save.
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The network diagram generated in Vista is used as the home page when you access the Diagrams
application.

Displaying Vista network diagrams online
Use one of the following procedures to view theWeb version of the network diagram generated in
the Vista component of PowerMonitoring Expert.

From a Web client computer

1. Start Internet Explorer.

2. Enter http://domain_name/Web in the address field to open theWeb Applications login
dialog (where domain_name is the Internet address for the server hosting theWeb
Applications component of PowerMonitoring Expert).

For example, for server name srv1 and company nameMyCompany, enter the address in the
browser as:

http://srv1.MyCompany.com/Web

If you cannot access the Diagrams application, the product may have been installed on the
server with a different virtual root than the default of Web. Contact your system administrator for
the full address.

3. Enter your user name and password and click Log In.

4. Click theDiagrams icon on the Navigation Bar to view the network diagram.

The network diagram that was created in Vista is displayed. Click an icon to display its
contents (for example, click the group icon to display themeters belonging to that group).

From the primary server

1. Double-click the PowerMonitoring Expert folder, then double-click Web Applications to open
theWeb Applications login dialog.

2. Enter your user name and password and click Log In.

3. Click theDiagrams icon on the Navigation Bar to view the network diagram.

The network diagram that was created in Vista is displayed. Click an icon to display its
contents (for example, click the group icon to display themeters belonging to that group).

Viewing historical (trend) data
The Diagrams application provides aWeb-based graphing utility for viewing historical data. This
utility allows you to select the date range and the data that you want to view.

1. Click themeter icon to open its diagram, then click the link or tab that contains the button for the
trending information you want to view.

2. Click the Data Log Viewer button that corresponds to the data log you want to view.

The data log table displays today's data by default.

When the data log table opens, 30 rows of data are displayed initially. As you scroll or page
down, 30 additional rows of data at a time are added to the table.

3. Click Change Date Range to change the timeframe for the data and select one of the available



options for the data that you want to view. To specify a custom date range, select Between

these dates then click the calendar icons to set start and end dates.

The new date range is applied when you view the graph. Click Show Table to return to the data
log table. (When you return to the data log table, your previous table header selections are
cleared.)

If you select a custom date range, amaximum of 6000 rows of data are displayed initially. If the
custom date range includes more than 6000 rows of data, you can display the additional records
in increments of 30 rows at a time by scrolling down or pressingEnd.

4. Select the check boxes for the items in the table header for the parameters that you want to
graph.

5. Click Show Graph.

6. Manipulate and control the displayed graph by doing the following:

a. To zoom in on the graph, left click and drag themouse pointer around the portion you want
to zoom in on.

b. To restore the graph to its original display size, double-click anywhere in the graph.

7. Click:

a. Device Diagram to return to that page.

b. Change Date Range to select a different date range for the data log table. The new date
range is applied when you view the graph.

c. Show Table to return to the data log table. (When you return to the data log table, your pre-
vious table header selections are cleared.)

RMS waveform plotting
The Diagrams application plots the calculated root mean square (RMS) values for waveforms. To
show or hide these RMS values, select the appropriate check box for the waveform in the data
table.

Viewing meter events
You can view meter events in a table format using the Diagrams application.

NOTE: You cannot acknowledge alarms on the screens generated by the Diagrams application
since control functions are not supported. To acknowledge alarms, click theAlarms icon in the
Web Applications component to open the Alarms viewer.

Viewing the meter events

1. Click themeter icon to open its diagram, then click the link or tab that contains theMeter events
button.

2. Click theMeter events button to open the a table showing themeter events.

Themeter events table displays today's data by default.

When themeter events table opens, 30 rows of data are displayed initially. As you scroll or
page down, 30 additional rows of data at a time are added to the table.

3. Click Change Date Range to change the timeframe for the data and select one of the available
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options for the data that you want to view. To specify a custom date range, select Between

these dates then click the calendar icons to set a start and end date.

If you select a custom date range, amaximum of 6000 rows of data are displayed. If the custom
date range includes more than 6000 rows of data, you can display the additional records in
increments of 30 rows at a time by scrolling down or pressingEnd.

Adding a Global Event Log Viewer
To display the Vista Global Event Log Viewer online, you need to create an Event Log Viewer object
in the Vista diagram and link it to the Global Event Log. To add this object to the home page for the
Diagrams application:

1. Open network.dgm in Vista andmake sure you are at the top level (that is, the title bar displays
User Diagram:network). Select Options > Show Toolbox to switch to Edit mode.

2. Drag an Event Log Viewer object onto the diagram, then right-click the object to display its prop-
erties.

3. Click theQuery tab, then click Edit Query.

4. Select Global, click Add, then click Next.

5. Select Global Event Log @Global, click Add, then click Next.

6. Select at least one column other than * in theAvailable section and then click Add. If you want
to change the order of selected columns, select the column in theSelected section then use the
up or down arrow buttons tomove it accordingly.

7. Set a filter to display only alarms:

Use the Filter section to select priority, and >= in the respective lists, and enter 128 in
the text field.

Click Insert to add the filter to theWhere field.

8. Click Next.

9. Select the column you want to assign as the first sorting criteria, then click Add. Repeat for the
second sorting criteria, and so on. In theSort Order section, double-click a column to change
its sort order (for example, to change from “ascending” to “descending”).

10. Click Finish, then click OK to close theEvent Log View Configuration dialog.

11. Click File > Save.

Stale data and error indicators
The Diagrams application uses the Vista stale data settings for its diagrams. Stale data and errors
are displayed in the browser as follows:

l A yellow border surrounding an object indicates stale data.

l An orange border surrounding an object indicates an error in communications, security access,
configuration, or other system error.



NOTE: See the "Identifying Stale Data" topic in the Vista section of the onlinePowerMonitoring
Expert Help for information on stale data. Although you can change the stale data and error flag
colors in Vista, the color indicators for these flags do not change in the Diagrams application.
Contact Technical Support if you need to change the default Diagrams flag colors.

Advanced Diagrams configuration
Customization and advanced configuration information for the Diagrams application is intended for
advanced users only.

See the following topics for additional information:

l Custom network diagram setup describes how to change registry settings to use a custom net-
work diagram instead of the automatically generated network diagram.

l Diagrams registry settings describes registry entries and settings used in the Diagrams applic-
ation.

Custom network diagram setup
If you have a custom network diagram on the primary server that you want to use instead of the
automatically generated network diagram, you need tomodify the registry settings of the computer
where you run the Diagrams application to specify the location of the custom network diagram.

Modifying system registry keys without sufficient knowledge or experience in these procedures can
damage the computer's operating system and all existing data.

NOTICE
OPERATING SYSTEM DAMAGE OR DATA CORRUPTION

• Beforemaking any changes to your system registry, back up the registry to a network folder or
other remote location.

• Only advanced users with knowledge of operating system registry entries should use the
Registry Editor.

Failure to follow these instructions can require operating system re-installation.

1. Start Windows Registry Editor and navigate to:

HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\PowerMonitoring
Expert\8.0WebReach

If the Diagrams application is run on a 64-bit operating system, navigate to:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider Electric\PowerMonitoring
Expert\8.0\WebReach

2. Right-click to add a new string value and name it “NetworkDiagram”.

3. Right-click NetworkDiagram, selectModify, then type the path and name of your custom net-
work diagram in theValue data field.

4. Click OK.

5. Restart IIS on your computer to apply the changes.
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Formore information, refer to theNetworkDiagram item in the table under Diagrams registry
settings. If there is no NetworkDiagram entry in the registry, then the default value “x-
pml:/diagrams/ud/network.dgm” is used.

The Network Diagram navigation button located on the date range page and the results page is
automatically updated to link to the custom network diagram you specified. However, the Network
Diagram button that exists in eachmeter user diagram uses a hard-coded link to “x-
pml:/diagrams/ud/network.dgm”. Use Vista tomanually update the Network Diagram link in the
meter user diagrams. If you do not have access to Vista, contact your system administrator to
change the link for the grouping object in the network diagram as described below.

Changing the link for the grouping object in the network diagram

1. Start Vista and select Options > Show Toolbox to switch to Edit mode.

2. Right-click the grouping object in the network diagram to open theGrouping Object Con-
figuration dialog.

3. Select theAction tab and select Open User Diagram.

4. Click Browse to locate your custom network diagram. Select the diagram filename, then click
Open.

5. Click OK to save your changes.

Diagrams registry settings
The registry keys for Diagrams on a 32-bit system are located in HKEY_LOCAL_
MACHINE\SOFTWARE\Schneider Electric\PowerMonitoring Expert\8.0\WebReach.

On a 64-bit system, the registry keys are located in HKEY_LOCAL_
MACHINE\SOFTWARE\Wow6432Node\Schneider Electric\PowerMonitoring
Expert\8.0\WebReach.

The following table lists the default Diagrams registry entries and settings.

Default Registry
Entries

Default Setting Desciption

AutoDiagramTimeout 20000milliseconds
Timeout period for the autodiagram components to communicate
with the device and determine the appropriate template to open.

ExpireTimeLimit 600 seconds
Time limit for a diagram subscription to update its timestamp. If
the subscription is not updated within this time period, it is
considered expired and is removed.

HTTPRefreshInterval 10 seconds The webpage refresh rate.

SubscriptionObject pmlitem:webreachstore:
The name (tag) that the subscription service uses to find
Diagrams-related information.

VirtualDirectory ION
The part of theWeb address that points to the Diagrams-
generated Vista diagrams for displaying in the browser.

XMLRefreshInterval 3000milliseconds The real time data update rate on the webpage.



The following table lists the optional registry entries you can set for custom functionality. Modifying
system registry keys without sufficient knowledge or experience in these procedures can damage
the computer's operating system and all existing data.

NOTICE
OPERATING SYSTEM DAMAGE OR DATA CORRUPTION

• Beforemaking any changes to your system registry, back up the registry to a network folder or
other remote location.

• Only advanced users with knowledge of operating system registry entries should use the
Registry Editor.

Failure to follow these instructions can require operating system re-installation.

Optional Registry
Entries

Default Setting Description

NetworkDiagram
x-pml:/diagrams/ud/
network.dgm

This value specifies the network diagram to display as the
homepage for Diagrams. The value can be a relative path, such as
the default setting, or it can be an absolute file path (e.g.,
D:\customdiagrams\ud\networkB.dgm).

QueryTimeout See description

This value determines how long Diagrams waits for the results of a
query to return from the database before timing out. If this registry
entry is not created or noQueryTimeout valus is specified,
Diagrams times out after 60 seconds.
This optional registry entry is useful if you know that a query will
takemore than 60 seconds to return its results and you do not want
Diagrams to time out before then. Specify a value that gives you
enough time to get your query results.

Troubleshooting
Diagrams depends on the ION XMLSubscription Service and ION XMLSubscription Store Service
to function properly. If you are experiencing difficulties with Diagrams pages (such as getting an
error message when you try to open a device diagram), check tomake sure these services have
been started.

Unable to access the Diagrams application

If you cannot access the Diagrams application, the product may have been installed on the server
with a different virtual root than the default of Web. For example, the default address is
http://domain_name/Web, where domain_name is the Internet address of the server hosting the
Diagrams application. Contact your system administrator for the full address.
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No real-time data is displayed

This may be caused by security settings being reset by aMicrosoft Windows update on the server.
If this is the case, open Internet Explorer on the server, select Tools > Internet Options, then click
theSecurity tab. Click the Trusted sites icon, then click Sites. Add theWeb Applications site in
the form of http://domain_name/Web to the Trusted sites zone. For example, for server name
srv1 and company nameMyCompany, add theWeb site as:
http://srv1.Mycompany.com/Web

Page cannot be displayed

This may be caused by complex or large queries, such that the results do not arrive within the
default Diagrams timeout setting of 60 seconds. If you suspect this is the case, add the custom
DWORD registry key QueryTimeout and set it to a higher timeout value (for example, to 120 for
120 seconds).

Tick labels for gauges are unreadable

This may occur if you specify an unsupported font for the Ticks Label Font. To fix this, select only
TrueType orOpenType fonts in Vista.



Tables
The Tables application allows you to quickly build an on-demand view of real-time data from devices
configured in theManagement Console component of your StruxureWare™PowerMonitoring
Expert system.

WARNING
INACCURATE DATA RESULTS

• Do not incorrectly configure the software, as this can lead to inaccurate reports and/or data
results.

• Do not rely solely on data results to determine if the system is functioning correctly or meeting
all applicable standards and compliances.

• Do not use reports or data results as substitutes for proper workplace practices or equipment
maintenance; they are supplemental only.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

When you click the Tables icon on the Navigation Bar, the application window opens with a table
display pane on the left, and a table configuration pane on the right.

Table display pane
The table display pane on the left contains a table header area above a data display grid area.

Table header
The table header contains the following fields and options:

Field or Option Description

Table
Displays the title of the table selected in the Table Library. For
tables that you defined, this field shows the table name that you
saved.

Export
Opens theSave Aswindow, where you can save the table as an
Excel (XLsx) file.

Last Update
Displays the server date and time when the data in the table was
last refreshed. Before youmake any selections for a real-time
table, the text reads No data displayed.

Update in /
Updating

Provides a countdown for the interval that you select. All time
intervals are expressed as minutes and seconds in anmm:ss
format. Changes toUpdatingwhen the countdown reaches 0. If
theUpdate Interval is set toContinuous, the label always
indicates Updating.

Pause / Resume

Stops the next update countdown and retains the current data in
the table. When you select Pause, the text changes toResume.
When you select Resume, the countdown continues for the
remaining time inNext Update.

Update Interval
Shows the default refresh rate for the data in the table. The initial
setting is 5 seconds, but you can choose other time periods from
the list.
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Data display grid
The data display grid is the area where the real-time data displays. The data is organized by device
name in the left column of the grid, andmeasurement headings arranged in columns across the top
of the grid.

Table configuration pane
The table configuration pane on the right contains panels labeled Table Library, Devices, and
Measurements that you use to select and configure a real-time table.

Table Library
The Table Library contains pre-defined and user-defined tables that are grouped under their
respective folders. The number of folders that you see depends on your PowerMonitoring Expert
system access privileges.

The folders are:

l System: contains pre-defined tables included in PowerMonitoring Expert.

l Shared: contains user-built tables that are visible to all users.

l Private: contains your user-built tables.

l Other User Tables: contains tables created by other users and saved in theirPrivate folder. The
Other User Tables folder is visible to users with an access level of Supervisor. Each table
name in this folder is identified with the owner's user name.

Use the icons at the top of the Table Library to complete the following actions:

New
Clears the table display pane. Select one or more devices and
measurements for the new table.

Save
Opens theSave Table dialog. You can enter a name for the table and
indicate whether to save it in your private or shared folder.

Edit
Opens theSave Table dialog for the selected table. Modify any of the
settings for the table and click OK.

Delete
Permanently deletes a table. Users with supervisor-level access can
delete any table that appears in the Table Library. All other users can
only delete tables that they created.

Access levels and table folder visibility

Your access level determines which folders are visible in the Table Library. The following summary
shows the folders that are visible for each access level.

Access privileges
Table Folders

System Shared Private Other User Tables
Observer (View Only) Yes Yes Yes No
User Yes Yes Yes No
Controller Yes Yes Yes No
Operator Yes Yes Yes No
Supervisor Yes Yes Yes Yes



Devices
The Devices panel lists all of the devices, organized by group names, that are configured in your
PowerMonitoring Expert system.

Measurements
TheMeasurements panel lists all of themeasurements associated with the devices configured in
your PowerMonitoring Expert system. Themeasurements are grouped in categories, such as
Current, Energy, Power, Voltage. It also includes a Favorite Measurements category.

Use the icons at the top of theMeasurements panel for the following actions:

Open the
measurement
filter

Opens themeasurement filter dropdown list. The default selection is
All. Select Common to list themore commonly usedmeasurements
within each category.

Click the icon to close themeasurement filter list.
Edit Favorite
Measurements

Opens the Favorite Measurements dialog. Use the dialog to add, edit,
or delete a favorite measurement and click OK.

Favorite Measurements

Favorite Measurements provides a way to convert an existing devicemeasurement to a calculated
value for display in the real-time table. Favorite measurements can be configured, modified, or
deleted by users with access levels of Operator, Controller or Supervisor. Each defined favorite
measurement is available for selection in a real-time table.

Creating a favorite measurement

1. Click theEdit Favorite Measurements icon to open the Favorite Measurements dialog.

2. Click Add to open themeasurement configuration dialog:

3. In the Type list, select:

All to display all measurement categories.

A specific category in the list to display themeasurements for that category. Available cat-
egories areAir, Electricity, Environment, Generic, Natural Gas, Steam,Wastewater,
andWater.

4. In theShow list, select:

All to display all available measurements within each category specified by your Type
selection.

Common to display a list of themost commonly usedmeasurements within the categories
specified in your Type selection.

Consumption to display only measurements related to consumption within the categories
specified in your Type selection.

5. Enter a name in theDisplay Name field for the column label in the table.

6. Enter a unit of value in theDisplay Unit field to represent the underlyingmeasurement, such
as, kWh, kVAR, kVARh, and so on.

7. Enter amultiplier value in theMultiplier field to convert the data read from the device to a value
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for display in the table.

Using amultiplier of 1 lets you organize your favorite measurements into this convenient group.

8. Click OK to save the favorite measurement.

The favorite measurement is available for selection in theMeasurements panel under the
Favorite Measurements category.

Getting started
When you select Tables on the Navigation Bar, the application opens and instructions appear in the
data display area.

Please Select:

A Table and one or more Devices.

or

One or more Measurements and one or more Devices.

The instruction to select A Table and one or more Devices refers to selecting a table in the
System folder of the Table Library, and then adding devices to the table by selecting them in the
Devices panel. This instruction also applies to selecting a user-built table in theShared folder when
the table definition does not include devices. See Selecting a pre-defined table for further
information.

The instruction to select One or more Measurements and one or more Devices refers to
creating a table by selectingmeasurements and devices from theMeasurements andDevices
panels, respectively. See Creating a user-defined table for further information.

Note that if you are viewing a table and log out of the application or close the browser, the table you
last viewed is automatically loaded when you return to the Tables application.

Selecting a pre-defined table
Pre-defined tables are located in theSystem folder in the Table Library.

Each of the pre-defined tables has a specific set of measurements that appear as column headings
in the data display grid.

The Table Library displays all of the tables that are available for selection. This includes pre-
defined tables in theSystem folder, user-defined tables in theShared folder, and any of your own
tables in thePrivate folder. The following information is specific to the tables in theSystem folder.

Selecting a table first, then devices

To display real-time data by selecting a table definition first, complete the following steps:

1. Select a table listed in theSystem folder orShared folder.

Themeasurements associated with the selected table appear as column headings on the
data display grid.

The table title appears in the header area.



The prompt in the data display grid indicates that you need to select one or more devices.
(For a table in theShared folder, this instruction appears only if devices had not been saved
with the table definition.)

2. Select specific devices from the list (organized by group name) in theDevices panel.

The device name appears under theDevices column in the data display grid.

Real-time data begins to display in each of themeasurement columns.

The Last Update field shows the date and time of the last data update.

If you select another table in theSystem folder (orShared folder) where devices have not been
specified as part of the table definition, the existing table is replaced with the new set of
measurement headings for the devices that you previously selected.

Selecting devices first, then a table

To display real-time data by selecting devices first, complete the following steps:

1. Select specific devices from the list (organized by group name) in theDevices panel.

The device name appears under theDevices column in the data display grid.

The prompt in the data display grid indicates that you need to select a table or one or more
measurements.

2. Select any of the tables from theSystem folder or a user-built table in theShared folder.

Themeasurements associated with the selected table appear as column headings in the
data display grid.

The table title appears in the header area.

Real-time data begins to display for the selected devices.

The Last Update field shows the date and time of the last data update.

If you select additional devices, each device name appears under theDevices column and real-time
data begins to display in each of themeasurement columns.

Note that if you add or rename devices in Management Console while you are logged in to the
Tables application, the additional or renamed devices are not listed in theDevices panel unless you
log out of the Tables application for 15minutes, and then log back in.

Creating a user-defined table
User-defined tables are a combination of both the devices and themeasurements that you select
from theDevices andMeasurements panels, respectively.

To create a user-defined table, complete the following steps:

1. If the data display grid already contains data, you can clear the grid by clickingNew (the + icon)
at the top of the Table Library panel, and then complete the following steps.

2. Select one or more devices (organized by group name) listed in theDevices panel.

The device name appears under theDevices column in the data display grid.

The prompt in the data display grid indicates that you need to select one or moremeas-
urements.
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3. Select one or moremeasurements to associate with the selected devices.

Themeasurements appear as column headings in the data display grid.

Real-time data for the devices appears in themeasurement columns.

To refine your table, modify your selection of devices andmeasurements.

To save your table, click theSave icon to open theSave Table dialog.

l If you save a table with measurements but without devices, a green circle appears beside the
table name.

l If you save a table with both devices andmeasurements, then a green checkmark appears
beside the table name.

l If you attempt to save a table without any measurements, you are prompted to select one or
moremeasurements before you can save the table.

To clear the data display grid, select Clear Selection at the top of both theDevices and
Measurements panels, respectively. Alternatively, you can click New and select No on the save
table prompt to clear the data display grid.

Note that if you add or rename devices in Management Console while you are logged in to the
Tables application, the additional or renamed devices are not listed in theDevices panel unless you
log out of the Tables application for 15minutes, and then log back in.

Saving your table
After you have configured the table to display the data that you want to see, you can save the table
in the Table Library for selection at another time.

1. Click theSave icon at the top of the Table Library panel to open theSave Table dialog.

2. Complete the following on theGeneral page:

a. Enter a table name inName field.

b. Select Private orShared as the access option for the table.

This selection determines who can view, edit or delete the table.

Note that tables are saved in thePrivate folder by default for users with an access level of
Observer or User.

c. If you want to change your selection ofMeasurements orDevices, complete the following
steps. Otherwise, click OK to save your table.

3. Click Measurements to open that page:

Themeasurements that you selected when you defined your table are also selected on this
page.

If you want to refine themeasurements associated with your table, you can add or remove
measurements by selecting or clearing the adjacent check boxes.

4. Click Devices to open that page:

The devices that you selected when you defined your table are also selected on this page.



If you want to refine the devices associated with your table, you can add or remove devices by
selecting or clearing the adjacent check boxes.

5. Click OK to save your table in thePrivate or theShared folder in the Table Library.

The folder for the saved table is determined by the access option that you selected on the
General page.

Sorting and filtering data
You can sort and filter data in the data display grid by using the controls and options available in the
column headings.

Sorting data
To sort data into a specific order or sequence in the data display grid, click the column heading. The
first click sorts the data in ascending order, and the second click sorts the data in descending order.

l For the Devices column, the list of devices is sorted in ascending or descending alphabetical
order by group name and then by device name.

l Formeasurement columns, themeasurement data is sorted in ascending or descending numer-
ical order.

Filtering data
To filter data in the data display grid:

1. Click the arrow in a column heading to display the filter settings for that column.

The settings provide an operator selection list and a numeric field.

2. To change the filter parameter, open the parameter list and select one of the operators.

3. Enter a numeric value associated with the data in the column that you want to filter.

4. If you select theOr orAnd option, the operator list and numeric field below the option are
enabled for further filter definition.

5. Click Filter to filter the data that appears in the column based on your selections.

A filter icon appears on the right of the column heading to indicate that a filter is applied to
the data in the column.

To remove filtering for a column:

1. Click the filter icon in a column heading to display the filter settings.

2. Click Clear to remove all entries from the filter.

Exporting a table
To export a table to an Excel spreadsheet:

1. Select theExport link above theDevices column to open theSave As dialog.

2. In the File name field, enter a name for the table that you are exporting.
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3. TheSave as type field indicates the file type of Xlsx.

4. Click Save to export the table and to return to the Tables application.

After you have exported the table, you can open the Excel file and save it in another format, for
example, as a PDF file for printing or distribution.

User permissions
The following table summarizes user permissions for specific table operations. User permissions
are assigned through User Manager, which is accessible from the Toolsmenu inManagement
Console.

Operation Allowed
User Permissions

Observer User Controller Operator Supervisor
View a pre-defined table in the System
folder.

Yes Yes Yes Yes Yes

View a user-defined table in the
Shared folder (saved with the Shared
option).

Yes Yes Yes Yes Yes

Create, view, edit, delete your own
table in the Private folder (saved with
the Private option).

Yes1 Yes1 Yes Yes Yes

Save a table with the Shared option. No No Yes Yes Yes

Delete any table created by other
users.

No No No No Yes

Delete a pre-defined table. No No No No Yes
1 Tables are saved in the Private folder by default for users with access levels of Observer or User.



Trends
The Trends application allows you tomonitor current system conditions by displaying real-time data
in a graphical format. You can configure trend settings to include data from the database as it is
logged (referred to as historical data), or you can combine real-time data and historical data in the
trend diagram. In addition, you can save the trend data as a csv file.

WARNING
INACCURATE DATA RESULTS

• Do not incorrectly configure the system; this can lead to incorrect reports and/or data results.
• Do not rely solely on reports or data results to determine if the system is functioning correctly
or meeting all applicable standards and compliances.

• Do not use reports or data results as substitutes for proper workplace practices or equipment
maintenance; they are supplemental only.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

A Title B Upper threshold C Lower threshold
D Target line E Left axis F Scale ( from View setting)
G Right axis H Axis title I Trend options
J Legend K Close/open toggle

Getting started
When you select Trends on the Navigation Bar, the application opens with the following
instructions in the trend display pane.

To add content, enable an existing Trend or create a new Trend

The instruction to enable an existing Trend refers to selecting one or more trends in theShared,
Private, orOther User Trends folders in the Trend Library. (TheOther User Trends folder is
available only for users with supervisor-level access.)

The instruction to create a new trend refers to clicking the plus icon at the top of the Trend Library
pane to open theAdd Trend dialog.
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The Trends interface
The Trends interface consists of a display pane on the left and a library pane on the right.

The display pane

The Trends display pane is the area where trend diagrams and data are displayed. See "Available
options for a trend" for information about the icons that are available when a trend opens in the
display pane.

When you create a trend, it automatically opens in the display pane and the checkbox for the trend
is selected in the Trend Library. Three trends are visible in the display pane at any one time. You
can scroll the display pane to view additional trends that have been selected.

If you log out of the application, your selections are preserved and are loaded in the display pane
when you log in at a later time.

The library pane

The Trend Library contains trends that have been created and grouped under their respective
folders. The number of folders that you see depends on your PowerMonitoring Expert system
access privileges.

The folders are:

l Shared: contains user-defined trends that are visible to all users.

l Private: contains trends that you created as private trends.

l Other User's Trends: contains trends created by other users and saved in theirPrivate folder.
TheOther User's Trends folder is visible to users with an access level of Supervisor. Each
trend in this folder is identified with the owner's user name.

Use the icons at the top of the Trend Library to complete the following actions.

Add
Opens theAdd Trend dialog. Click the tabs in the dialog to configure
the new trend.

Duplicate
Opens theDuplicate Trend dialog. You can enter a new title and
indicate whether to save the duplicate in your private or shared folder.

Edit
Opens the Trend Setup dialog. You canmodify any of the settings for
the trend.

Delete
Permanently deletes a trend. Users with supervisor-level access can
delete any trend that appears in the Trend library. All other users can
only delete trends that they created.

Select or clear the checkbox beside a trend name in the Trend Library to display or remove it from
the display pane.

Right-click a trend to open the context menu. This menu is available whether or not you selected the
checkbox to view the trend. Enabledmenu items are dependent on your access level. For example,
users with an access level of Supervisor can duplicate or delete another user's trends, but they
cannot open the trend in a new window or edit the trend.



Themenu items are:

l Open in New Window: opens the trend in a new window or on a separate tab in your browser. If
you want to share the trend with other users or applications within your system network, copy
the URL from the address field of the new browser window or tab, and distribute it via email or
instant messenger (IM), embed it in aWeb page, and so on. Note that access to the trend is
dependent on site policies and user access privileges.

l Duplicate: opens theDuplicate Trend dialog. See "Duplicating a trend" on page 67 for more
information.

l Edit: opens the Trend Setup dialog. See "Modifying a trend" on page 67 for more information.

l Delete: opens the delete trend confirmation window. Click OK to delete the trend orCancel to
cancel the deletion.

See the following topics for additional information:

l "Adding a trend" on page 61

l "Modifying a trend" on page 67

l "Duplicating a trend" on page 67

l "Deleting a trend" on page 67

Adding a trend
To add a trend:

1. Click the plus icon to open theAdd Trend dialog.

2. On theGeneral tab:

a. Enter a title for the trend.

b. Click Add underData Series to open theAdd Data Series dialog.

c. Select a device in theSources area of the dialog by clicking the device name.

By default, the sources are listed in alphabetical order by group name and by device name
within a group. You can use theSearch field to find entries by device name, group name, or
a combination of group and device names.

Click Advanced to show theGrouping list, and select how you want to list the devices
displayed in theSources area.

NOTE: For large systems with many devices, it takes longer to choose a source from the
source selector if you change theGrouping setting from its default value.

d. For the selected device, expand ameasurement type, for exampleVoltage, and click the
specific measurement you want to include in your trend, for exampleVoltage A-B.

Themeasurements are list in alphabetical order by measurement category. You can use
theSearch field to find a specific measurement category or measurement.

e. Select Custom Name if you want to enter a series name of your choice for trend data pur-
poses. By default, a series name is a combination of device andmeasurement information
formatted as group.device measurement, for example BldgA.meterA Voltage

A-B.
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f. Similarly, you can select Custom Units and enter a unit description of your choice.

g. You canmodify the following settings for each sourcemeasurement:

Style: select the color and line thickness from the available choices in the dropdown
menus.

Decimals: select the number of decimal places for the data displayed in the legend.

Plot on: select Right or Left Axis for the location of themeasurement values for the
selectedmeasurement.

Overlay: select the values that you want to overlay on the trend diagram. By default, no
items are selected. The selections areMin,Max, andMean.

Data Source: select where to access the data for the trend diagram. The options are to
gather series data from the device in real-time, gather series data from the database as
it is being logged, or gather real-time series data from the device and historical data
from the database to fill the trend diagram, if possible.

h. Click OK to save your changes and close theAdd Data Series dialog and to return to the
Add Trend dialog.

i. Click Add to specify additional devices andmeasurements for the trend.

j. Select Private orShared to save the trend in the private or shared folders, respectively.
Private is selected by default.

3. On theAxes tab:

a. Enter a label for the axes in the Title field underRight Axis (Primary) or Left Axis
(Secondary).

Axis titles only appear if you have configured at least onemeasurement series and it
appears on the trend diagram.

b. ForRight Axis (Primary) select Auto orCustom forMax Value for the data in the dia-
gram. Auto is the default.

c. Select Custom to enable theMax Value input field and theUpper Threshold checkbox.

ForCustom, specify themaximum value for the data by entering a value in theMax Value
input field.

If you select Upper Threshold:

Select a color from the color selector for area shading on the trend diagram between the
maximum value and the upper threshold value.

Enter a value for the upper threshold in the input field.

Each time the latest data point of ameasurement series occurs in an upper or lower
threshold, the color defined for the threshold also colors the background of the
measurement series in the legend.

d. Select Auto orCustom forMin Value for the data in the diagram. Auto is the default.

e. Select Custom to enable theMin Value input field and the Lower Threshold checkbox.



ForCustom, specify theminimum value for the data by entering a value in theMin Value
input field.

If you select Lower Threshold:

Select a color from the color selector for area shading on the trend diagram between the
minimum value and the lower threshold value.

Enter a value for the lower threshold in the input field.

If the latest data point of ameasurement series occurs in an upper or lower threshold,
the color defined for the threshold also colors the background of themeasurement
series in the legend.

f. Select Target Line then select a color from the color selector and enter a value for the
target line in the input field.

You can select the Target Line independently from theUpper Threshold or Lower
Threshold settings.

g. For Left Axis (Secondary) select Auto orCustom forMax Value andMin Value for the
data in the diagram. Auto is the default.

ForCustommaximum orminimum, enter the values in the respective input fields.

4. On theChart tab:

a. Select the text size from the list.

The text size property is applied to trend axis labels, the size of the legend, the legend text
size, and trend data point tooltips.

The default setting is Medium, and the choices areSmall,Medium, or Large.

b. Select the position of the legend included in the trend display area from the list.

The default setting is Right, which places the legend on the right side of the trend diagram.
The available choices areOff, Left, orRight.

c. Select the content that you want to include in the legend from the available settings.

The default selections areName andValue. The additional selections areDifference and
Difference (%).

Name is either the default measurement name in the form of group.device
measurement, or the custom name that you specified on theAdd orEdit Data Series
dialogs.

Value is latest data value and the unit of measurement. For example, for voltage
measurements, the default value is numeric_value V such as 415.2 V.

Difference is the change in themeasurement from one update to the next. For example, if
the voltage is 415.8 and it changes to 416.1 at the next trend update, the difference
appears as +0.3 in the legend.

Difference (%) is the percentage change in themeasurement from one update to the next.
For example, if the voltage changes from 415.8 to 416.1 at the next trend update, the
difference expressed as a percentage appears as +0.072% in the legend.
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5. On theData tab:

a. Specify theData Update Intervals in the From device and From database dropdown
lists.

The default setting is 5 seconds for data updates for Trends using the data directly from a
device, and 5 minutes for data updates for Trends with data from a database.

b. Specify theData Points for the x-axis of the trend diagram in theMax per series input
field.

The default setting is 40000.

The valuemust be between 100 and 500,000. Increasing the value adds more data points
per series but this can result in a degradation of trend performance.

Examples:

A data interval of 1 second equates to 3600 data points per hour (60 points per minute X
60minutes per hour). At a setting of 40000 points, approximately 11.1 hours of data is
retained for viewing (40, 000 points / 3600 points per hour = approximately 11.1 hours).

A data interval of 5 seconds equates to 720 data points per hour (12 points per minute X
60minutes per hour). At a setting of 40000 points, approximately 55.5 hours of data is
retained for viewing (40, 000 points / 720 points per hour = approximately 55.5 hours).

A data interval of 10 seconds equates to 360 data points per hour (6 points per minute X
60minutes per hour). At a setting of 40000 points, approximately 111.1 hours of data is
retained for viewing (40, 000 points / 360 points per hour = approximately 111.1 hours).

6. Click OK to save your settings and to close theAdd Trend dialog.

Available options for a trend
The following set of options is available in the upper right when you open a trend in the display area.

These options are summarized in the following table.

Open the Diagnostic
Log Viewer

This icon only appears if there is an error
associated with the device. If the icon pulses,
the viewer contains new information that has not
yet been viewed. When you open the viewer you
can click Clear Log to remove the existing
entries. This action removes the icon from the
trend display area until new information is logged
in the viewer. Click Close to close the viewer
and return to the trend display.



View list

The setting for the time range on the X-axis.
Select a time range from the dropdown list. The
view window reflects the time inminutes or
hours from the last data point read from the
device. For example, if you are viewing a 15
minute window and the last data point occurred
20minutes ago, then the trend time range spans
the previous 35 to 20minutes.

Inspect

Acts as toggle to enable and disable the
inspectionmode for the trend diagram. When
you enable inspectionmode, inspect icons
appear on the trend diagram when you place your
pointer anywhere on the diagram. A slider also
opens below the X-axis. Use the slider to adjust
the time range for the trend. Data values are not
updated in the trend diagram but they continue to
be updated in the legend. When you disable
inspectionmode, all data that was captured is
shown.

Edit
Opens the Trend Setup dialog. You canmodify
any of the settings for the trend.

Download trend data
as CSV

Saves the current trend data that is displayed as
a CSV file on your system. When events occur,
you can download the data to a CSV file for
further analysis.

Maximize

Displays the trend diagram in a full browser

page. Click the Restore icon to return to the
default size in the trend display area.

Exit
Closes the trend diagram. This also clears the
checkbox for the trend in the Trend Library.

If you right-click a trend in the Trend Library and select Open in New Window from the context
menu, only theOpen the Diagnostic Log Viewer, View, Inspect, andDownload Trend Data as
CSV options are available.

The legend

The legend opens on the right of the trend diagram by default. You can select Left orOff on the
Chart tab in theAdd Trend or Trend Setup dialog to change the location of the legend or to remove
it from the trend display.
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The legend provides the following capabilities:

l You can close and open the legend by clicking the arrow on the left side of the legend.

l If you have enabledmultiple axes in your trend, when you place your mouse pointer over ameas-
urement series in the legend, it indicates which axis the series is drawn on.

l You can temporarily disable ameasurement series by clicking the color swatch for the series.

l The background color of ameasurement series entry changes tomatch the threshold colors
when the series passes into the upper or lower threshold. You set the threshold colors on the
Axes tab of theAdd Trend or the Trend Setup dialog.

Inspection mode

The following icons appear when you enable the inspectionmode and you place your pointer on the
trend diagram.

A Reset Zoom (100%) - resets the trend diagram to its default size.

B
Pan the chart - after you zoom in to an area of the diagram, click Pan the chart, then click
and hold the left mouse button on the diagram and drag it left or right.

C
Zoom in to selection area - zooms in when you drag themouse over an area of the chart.
The zoom action occurs when you release the left mouse button.

When the trend is in inspectionmode, the trend diagram remains static until you toggle inspection
mode off to return the trend diagram to its updatemode. Note that the data in the legend continues to
update in real time with the latest values even though the trend diagram remains static for analysis
purposes. When you toggle inspectionmode off, all of the data that was captured when you were in
inspectionmode is included in the diagram.

You can drag the slider below the X-axis to the right to decrease the time range for the trend. For
example, if the time range is set to 15minutes and you drag the slider to the right, the range values
decrease, and if you continue to drag the slider to the right, the values decrease further to show
minutes and seconds on the scale.



Modifying a trend
You canmodify a trend by selecting theEdit icon :

l Above a trend legend in the trend display area.

l In the Trend Library by selecting a trend and clicking theEdit icon.

l In the Trend Library, by right-clicking a trend and selecting theEditmenu item.

Tomodify a trend:

1. Click theEdit icon to open the Trend Setup dialog.

2. Retain or modify the settings for the trend in the Trend Setup dialog. (The settings are the
same as theAdd Trend dialog. See "Adding a trend" on page 61 for a description of the set-
tings).

3. Click OK when you complete any changes to save your settings and to close the Trend Setup
dialog.

Duplicating a trend
When you duplicate a trend, you can enter a new title and indicate whether to save the duplicate in
yourPrivate orShared folder in the Trend Library.

To duplicate a trend:

1. Select the checkbox for the trend in the Trend Library pane and click theDuplicate icon
to open theDuplicate Trend dialog.

2. Retain or modify the settings for the trend in theDuplicate Trend dialog. (The settings are the
same as theAdd Trend dialog. See "Adding a trend" on page 61 for a description of the set-
tings).

3. Click OK when you complete any changes to save your settings and to close theDuplicate
Trend dialog.

Deleting a trend
To delete a trend:

1. Select the checkbox for the trend in the Trend Library and click theDelete icon .

2. Click OK in theDelete Trend confirmation window to permanently delete the trend, or click
Cancel to return to the Trends application.

Users with supervisor-level access can delete any trend that appears in the Trend library. All other
users can only delete trends that they created.
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Alarms
NOTE: The Alarms application is not available for users logging in as Visitor, or whose access
level is Observer or User.

The Alarms application allows users to view system alarms and events in a tabular format. You can
tailor the system view to your needs by choosing which alarm states, priorities, date range, and
devices you want to view. You can also select the columns that you want to see, thus controlling
the information you find helpful. The Alarms interface includes an Alarms tab and an Events tab.

WARNING
INACCURATE DATA RESULTS

• Do not incorrectly configure the system; this can lead to incorrect reports and/or data results.
• Do not rely solely on reports or data results to determine if the system is functioning correctly
or meeting all applicable standards and compliances.

• Do not use reports or data results as substitutes for proper workplace practices or equipment
maintenance; they are supplemental only.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

From the Alarms tab, you can:

l View all system alarms (active/inactive, acknowledged/unacknowledged) for a specified time
period

l Link to waveforms that are associated with individual alarms

l Acknowledge alarms, singly or in groups

l Silence alarm annunciation

From the Events tab, you can:

l View all system events for a specified time period

On each of the tabs, you can select the columns of information that you want to display.

Alarms Tab
The Alarms tab displays alarm information in a tabular format.

You can select the information that displays (system view), and you can select the columns of data
you want to see. If waveforms are associated with alarms, you can also view them.

Alarm Annunciator
The Alarm Annunciator displays above the Navigation Bar except for users logged in with user-level
or observer-level access, or users who sign in as Visitor. When the annunciator is surrounded by a
flashing red border, there are unacknowledged alarms.

The Alarm Annunciator displays:
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l ( )the number of high priority unacknowledged alarms

l ( ) the number of medium priority unacknowledged alarms

l (  ) the number of low priority unacknowledged alarms

l ( and ) a "silence alarms" button that toggles between turning alarm annunciation
"on" and "off." These two icons flash off when the red border flashes off.
Click this button to toggle between "on" and "off."

View Devices/Waveforms

When awaveform is associated with an alarm, the icon displays in the left-hand column. To
view the associated device type:

1. Click in the left column of the event for which you want to view the waveform.

2. When the Diagrams window (also accessed via the Diagrams button) displays, click the Power
Quality tab.

3. ClickWaveforms / Sequence of Events.

4. Choose the period of time from which you want to view the waveform.

5. Click Show Table.

6. At the table listing the waveforms that were captured during the specified timeframe, locate the
waveform you want to view; check the boxes for themeasurements to be included in the wave-
form.

7. Click Show Graph to view the waveform.

For additional help in navigating and using Diagrams, click Diagrams in the help TOC.

Acknowledge Alarms
When you acknowledge an alarm, it no longer annunciates. The Acknowledgement column displays
the date and time that you acknowledged it.

Note: If more than one person tries to acknowledge an alarm at the same time, the first person who
completes the acknowledgment is displayed by the system. Although the second person will not be
prevented from continuing, only the first person's acknowledgment will be recorded.

There are three ways to acknowledge alarms:

l Click Acknowledge at the top of the alarm view. When the Acknowledge Alarm popup displays,
choose whether you want to acknowledge:

a. All unacknowledged alarms

b. The displayed unacknowledged alarms

c. The selected unacknowledged alarms.

d. Type a descriptive note (optional).

e. Click Acknowledge.

The alarm(s) are acknowledged.



l Click the Acknowledge button for any of the alarms. When the Acknowledge Alarms popup dis-
plays:

a. Type a note (optional)

b. Click Acknowledge.

The alarm is acknowledged.

l At the bottom of the screen, click Show Alarm Details to expand the bottom section.

If one alarm is selected, that alarm is listed. Click Acknowledge. When the Acknowledge
Alarms popup displays, choose whether you want to acknowledge all unacknowledged alarms,
the displayed unacknowledged alarms, or the selected unacknowledged alarms. Type a
descriptive note (optional). Click Acknowledge. The alarm(s) are acknowledged.

If multiple alarms are selected, themessages tells you that youmay acknowledge all selected
unacknowledged alarms. To do this, click Acknowledge All Selected. When the Acknowledge
Alarms popup displays, choose whether you want to acknowledge all unacknowledged alarms,
the displayed unacknowledged alarms, or the selected unacknowledged alarms. Type a
descriptive note (optional). Click Acknowledge. The alarm(s) are acknowledged.

Select Columns
Click theSelect Columns link to open theGrid Column Selector. From theGrid Column Selector,
you determine the columns that appear in the alarm view.

To select/deselect columns to appear in the alarm view, do one of the following:

l Click Select All to display all columns.

l Check the individual columns.

l Click Select None to clear the current selections.

Click Donewhen you are finished.

Set Alarm Views
You can choose the alarms you will view, based on state, priority, or date. See Set Alarm Views for
instructions.

View Alarm Details
To view expanded details about any alarm, select it and click Show Alarm Details at the bottom of
the page. The bottom of the page displays the information shown on the alarm line, as well as the
information created when it was acknowledged.

Alarms Tab Display Pane
The following table describes the possible columns in the Alarms display pane:

NOTE: Entries in bold in the alarm view are unacknowledged alarms.

Column Name Description
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Drag a column here ...

This area is used to group alarms according to column headings. When
you drag a column heading here, it creates a button with that column's
name. When you click this button, you display alarms for that column
only.

n/a
When a waveform is associated with an alarm, this column is flagged
with:

Active

When an alarm is active, this column is flagged with: . To deactivate

an alarm that is permanently active due to never receiving a dropout, see
the Deactivate Alarms tool in theManagement Console.

Acknowledgement

If the alarm is not yet acknowledged, this column has an "Acknowledge"
button. To acknowledge the alarm, click the button. When the
Acknowledge Alarm window displays, type the appropriate note, then
click Acknowledge.

You can acknowledgemultiple alarms. For instructions, see Acknowledge
Alarms.

After an alarm is acknowledged, this column displays the date and time
that it was acknowledged.

Acknowledged By
Before an alarm is acknowledged, this column is blank. After the alarm is
acknowledged, this column displays the ION log-in name of the user who
acknowledged it.

Condition*

The condition that caused the alarm. The condition can be a text string or
a number, depending on the configuration options available on a device.
When the alarm is active, this is the condition indicating that active state,
for example, ON. When the alarm is inactive, this is the condition
indicating that inactive state, for example, OFF.

Device The device that recorded the alarm.

Dropout Time
The date/time that the alarm dropped out, that is, when themeasurement
returned to a normal reading.

Dropout Value
The value of themeasurement when the alarm dropped out, that is,
returned to normal.

Duration
The length of time from when the alarm was triggered to when it dropped
out.

Priority

Alarm priority as it is established in the system. The icon for the priority
level displays here. Options are:

(high priority)

(medium priority)

(low priority)

Start Time The date/time that the alarm was first triggered, that is, the pickup time.
Type* The alarm type, as recorded from the device.



Value

When the alarm is active, this is the value of themeasurement when the
alarm is triggered, that is, the start value. When the alarm is inactive, this
is the value of themeasurement when the alarm becomes inactive, that
is, the end value.

Measurement Themeasurement associated with the alarm.
* The combination of the Type andCondition columns constitutes the effect and effect value of
the alarm. For example, "kVAR Alarm" in the Type column and "ON" in theCondition column
indicates that a setpoint status for setpoint module labelled "kVAR Alarm" has changed to the on
state.

Setting Views for Alarms
The Alarms configuration pane contains panels labeledAlarm View Library andSelected View
Settings that you use to select the alarms that are to be listed in the Alarms display pane.

Alarm View Library
Use theAlarm View Library in the right-hand pane to select from among pre-defined or user-
defined alarm views, which are grouped within their respective folders.

The folders are:

l System Views: contains the pre-defined alarm views:

Alarm History – displays all alarms of all states, whether acknowledged or unac-
knowledged, in the system.

All Active Alarms – displays all active alarms in the system.

All Active and Unacknowledged Alarms – displays all active, unacknowledged alarms in
the system.

All Unacknowledged Alarms – displays all unacknowledged alarms in the system.

Recent Alarms (24 hours) – displays all alarms from themost recent 24 hours.

l Shared Views: contains alarm views that are user-defined and are available for all users.

l Private Views: contains alarm views that you create and save in thePrivate Views folder.

l Other User Views: contains alarm views created by other users and saved in theirPrivate
Views folder. TheOther User Views folder is visible to users with an access level of Super-
visor.

Selected View Settings
The Selected View Settings panel contains subsections labeledAlarm State, Alarm Priority,
Dates, andDevices.

The selections within each of these subsections are summarized in the following tables.

Alarm State
The state options are not mutually exclusive. For example, you can list alarms that are both active
and unacknowledged.

WebApplications - Help Topics Alarms

© 2015 Schneider Electric. All rights reserved. Page 73 of 124



Alarms Web Applications - Help Topics

Page 74 of 124 © 2015 Schneider Electric. All rights reserved.

Alarm State

Active State

Select Active only to display all active alarms. Select Inactive only to
display all inactive alarms. Select Both to display both active and inactive
alarms. To deactivate an alarm that is permanently active due to never
receiving a dropout, see the Deactivate Alarms tool in theManagement
Console.

Acknowledged
State

Select Unacknowledged only to include all unacknowledged alarms.
Select Acknowledged only to include all acknowledged alarms. Select
Both to include both unacknowledged and acknowledged alarms.

Alarm Priority
High Priority Select to include high priority alarms.
Medium Priority Select to includemedium priority alarms.
Low Priority Select to include low priority alarms.

Dates
All Select All to include all alarms in the system, regardless of date.

Defined
Select Defined to choose a pre-defined time period, such as Last Hour,
Today, or This Week.

Custom
Select Custom to choose a specific date range. Then click next to the
Start date to open the calendar tool. Choose a start date. Repeat this action
for the end date.

Devices
Select All/Select
None

Click Select All to include every device that has been added to Power
Monitoring Expert or click Select None to exclude all devices.

Device list Select individual devices to include them in the alarm view.

Creating user-defined alarm views
User-defined alarm views are saved copies of alarm views available in theSystem Views, Shared
Views, or yourPrivate Views folders in theAlarm View Library panel.

When you log in toWeb Applications and access Alarms, theRecent Alarms (24 hours) view
displays by default.

You can immediately begin to create your own alarm view by completing the following steps:

1. Modify the contents displayed in the view by:

Selecting the columns that you want to include.

Changing the order of the columns.



Dragging a column header to the group-by column field.

Changing any of the settings underSelected View Settings for alarm states, priorities,
dates, and devices.

2. Click theCopy icon when you complete your view customization.

3. Enter a name for the view in theNew view name field.

4. Select Private orShared to specify that the new alarm view is for your exclusive use or that
you want it to be available for other users, respectively.

5. Click OK to save the new alarm view.

The header in the alarm display area now indicates your new view name.

Tomake any changes to your customized view:

1. Click the alarm view to open it in the alarm display area.

2. Modify any of the columns or settings.

3. Click theSave icon to save your settings.

To create an alarm view based on a previously saved view:

1. Click an alarm view to open it in the alarm display area.

2. Modify any of the columns or settings.

3. Click theCopy icon .

4. Enter a name for the view in theNew view name field.

5. Select Private orShared for the alarm view.

6. Click OK to save the new alarm view.

The alarm view on which the new alarm view is based retains its original settings.

To edit the name of the view or to change it from Private or Shared:

1. Click the user-defined view to open it in the alarm display area.

2. Click theEdit icon .

3. If desired:

a. Change the view name in theEdit view name field.

b. Change the view from Private orShared.

c. Click OK to save your changes orCancel to close the update panel.

To delete a user-defined alarm view:

1. Click the user-defined view and select theDelete icon .

2. Click Yes on theDelete View prompt to proceed orNo to cancel the deletion.

Events Tab
The Events tab displays event information in a tabular format.
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You can select the specific columns of data you want to see, and you can select the system view
(priority, date range, and devices) to be displayed.

Select Columns
Click theSelect Columns link to open theGrid Column Selector. From theGrid Column Selector,
you determine the columns that appear in the event view.

To select/deselect columns to appear in the event view, do one of the following:

l Click Select All to display all columns.

l Check the individual columns.

l Click Select None to clear the current selections.

Click Donewhen you are finished.

Set Event Views
You can choose which events you will view, based on priority, date, or devices. See Set Event
Views for instructions.

Events Tab Table
The following table describes the possible columns in the table:

Column Name Description
Timestamp The date and time that the event occurred.
Device The device that recorded the event.
Priority This is the priority level (0–255) that is assigned to the event.
Event The name of the event.

Value

When the event is active, this is the value of themeasurement when the
event is triggered, that is, the start value. When the event is inactive, this is
the value of themeasurement when the event becomes inactive, that is, the
end value.

Condition

The condition that caused the event. When the event is active, this is the
condition indicating that active state, for example, ON. When the event is
inactive, this is the condition indicating that inactive state, for example,
OFF.

Measurement Themeasurement observed: currents, volts, etc.

Id
The number associated with the event when it first occurred, automatically
assigned in chronological order.

Setting Views for Events
The Events configuration pane contains panels labeledEvent View Library andEvent View
Settings that you use to select the events that are to be listed in the Events display pane.



Event View Library
Use theAlarm View Library in the right-hand pane to select from among pre-defined or user-
defined alarm views, which are grouped within their respective folders.

The folders are:

l System Views: contains the pre-defined alarm views:

All Events – displays all events that occurred in the system.

Recent Events (24 hours) – displays all events that occurred in the system in the last 24
hours.

This Month's Events – displays all events that occurred in the system in the current month.

This Week's Events – displays all events that occurred in the system from Sunday through
Saturday of the current week.

This Year's Events – displays all events that occurred in the system in the current calendar
year.

l Shared Views: contains event views that are user-defined and are available for all users.

l Private Views: contains event views that you create and save in thePrivate Views folder.

l Other User Views: contains event views created by other users and saved in theirPrivate
Views folder. TheOther User Views folder is visible to users with an access level of Super-
visor.

Event View Settings
The Event View Settings panel contains subsections labeledEvent Priority, Dates, andDevices.

The selections within each of these subsections are summarized in the following tables.

Event Priority

Minimum Priority You can either type a number into each of the combo boxes, or click
the up or down arrow to select theminimum andmaximum priority
levels of events you want to view. Valid numbers are from 0 to 255.Maximum Priority

Dates
All Select All to include all events in the system, regardless of date.

Defined
Select Defined to display events from a pre-defined time period,
such as Last Hour, Today, or This Week.

Custom
Select Custom to choose a specific date range.

Then click next to theStart to open the calendar tool for
selection of a start date. Repeat this action for the end date.
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Devices

Select All/Select None
Click the appropriate link to either include every device or to
deselect all devices.

Device list Select individual devices to include them in the view.

Creating user-defined event views
User-defined event views are saved copies of event views available in theSystem Views, Shared
Views, or yourPrivate Views folders in theEvent View Library panel.

When you log in toWeb Applications and click theEvents tab in Alarms, theRecent Events (24
hours) view displays by default.

You can immediately begin to create your own event view by completing the following steps:

1. Modify the contents displayed in the view by:

Selecting the columns that you want to include.

Changing the order of the columns.

Dragging a column header to the group-by column field.

Changing any of the settings underEvent View Settings for alarm priorities, dates, and
devices.

2. Click theCopy icon when you complete your view customization.

3. Enter a name for the view in theNew view name field.

4. Select Private orShared to specify that the new event view is for your exclusive use or that
you want it to be available for other users, respectively.

5. Click OK to save the new event view.

The header in the event display area now indicates your new view name.

Tomake any changes to your customized view:

1. Click the event view to open it in the event display area.

2. Modify any of the columns or settings.

3. Click theSave icon to save your settings.

To create an event view based on a previously saved view:

1. Click an event view to open it in the event display area.

2. Modify any of the columns or settings.

3. Click theCopy icon .

4. Enter a name for the view in theNew view name field.

5. Select Private orShared for the event view.



6. Click OK to save the new event view.

The event view on which the new event view is based retains its original settings.

To edit the name of the view or to change it from Private or Shared:

1. Click the user-defined view to open it in the event display area.

2. Click theEdit icon .

3. If desired:

a. Change the view name in theEdit view name field.

b. Change the view from Private orShared.

c. Click OK to save your changes orCancel to close the update panel.

To delete a user-defined event view:

1. Click the user-defined view and select theDelete icon .

2. Click Yes on theDelete View prompt to proceed orNo to cancel the deletion.
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Reports
TheWeb-based Reports application allows you to select, configure, generate, andmanage
comprehensive reports based on historical data contained in your databases.

The reports are designed for energy consumption and usage, power quality compliance and
analysis, and generic system usage. The reports can be generated on a defined schedule and when
system events and device alarms occur, and then distributed via email or sent to a file share or a
printer.

CAUTION
INACCURATE DATA RESULTS

• Do not incorrectly configure the system; this can lead to inaccurate reports and/or data
results.

• Do not rely solely on reports or data results to determine if the system is functioning correctly
or meeting all applicable standards and compliances.

• Do not use reports or data results as substitutes for proper workplace practices or equipment
maintenance; they are supplemental only.

Failure to follow these instructions can result in injury or equipment damage.

NOTE: Users of the Excel-based Reporter application can continue to access it in StruxureWare™
PowerMonitoring Expert. See the "Reporter" topic in the onlinePowerMonitoring Expert Help for
additional information. Also note that a Reporting Client is available for installation on client
computers. See theStruxureWare PowerMonitoring Expert Installation Guide for information about
this optional setup type.

Reports terminology
l Report Definition: The report definition consists of such things as layout, the inputs that need

to be specified to run the report, and the information in the database that is accessed for that
report.

l Report Input Parameters (or Inputs): Parameters that must be entered before a report can be
generated. For most of the report definitions, default values for some of the parameters are
provided. You can change these values for your specific requirements.

l Report: A report that is generated from a report definition that has been saved with some or all of
its input parameters completed.

l Saved Report: A report that has been saved with all of its input parameters completed.

The Reports interface
When you click theReports icon on the Navigation Bar, the application opens with a display pane
on the left and a library pane on the right.

The display pane
The Reports display pane is the area where you specify the input parameters for a report, and where
the generated report displays. The input parameters are dependent on the report you select. See
Report input parameters for further information.
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Report toolbar
After you generate a report, the toolbar at the top of the display pane allows you to:

l Navigate through the pages of the report by using the forward and backward arrows.

l Use the Download report as dropdown list to download the report as a PDF file, an Excel doc-
ument, or a TIFF image file.

The library pane
TheReport Library allows you to select a report definition or a saved report to view or generate.
Your selection opens in the display pane. Click < on the bar at the right to open theReport Library
if it is not visible.

Report names are preceded by a report icon . Icons with a white circle indicate that you need to
enter at least some of the inputs. Icons with a black circle indicate that all of the inputs have
been saved; the report can be generated without entering any inputs.

Use the icons at the top of theReport Library for the following:

New  Create a new report from an existing report definition.

Save  Save a generated report.

Subscribe Create a subscription for the saved report.

Manage
 Manage reports by selectingManage, Share, orSubscribe
options.

Upload Report Template  Add a report definition to theReport Library.
Upload Report Pack  Add a report pack to theReport Library.

NOTE: The availability of reports in the Report Library is dependent on licensing. You can view all of
the report packs that are installed with the product by clicking theUpload Report Pack icon on the
Report Library toolbar. Only those report packs that are licensed can be uploaded if they do not
appear in the Report Library. For a licensed report pack, click Install on theReport Pack Install
dialog to upload the reports in the selected report pack.

Configuring options for the Reports application
UseReporting ConfigurationManager in Management Console (Tools > Reporting
Configuration > Reporting Configuration Manager) to specify the database to report on,
subscription delivery options, and regional formatting settings. See the "Reporting Configuration
Manager" topic in theManagement Console Tools section of the onlinePowerMonitoring Expert
Help.

Report definitions
The report definitions are organized within specific folders in theReport Library.

Descriptions of the individual reports are included in this section.

100 ms
Use the 100ms report definition to create a report of selected 100ms measurements from
PowerLogic™Circuit Monitors (for example, CM3000, CM4000, CM4250, and CM4000T).

The report displays timestamped values for each 100ms measurement selected.



Report inputs:

l Title

l Sources

l Measurements

l Reporting Period

l Include DataWarnings

l Source Label

Billing
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

Use the Billing report definition to create an itemized energy charge back report for a particular
source (e.g., tenant) over a given date range (e.g., month). The Billing Report definition uses
measurements specified in a rate file. The rate file is configurable and supports many different rate
structures.

Use the Billing Report to do the following:

Produce accurate tenant energy bills

Allocate costs to departments or processes

Verify utility bills

NOTE: The report inputs use themeter hierarchy or the virtual meter as the sources. A hierarchy is
required for the Billing report to run.

Report inputs:

l Title

l Tenant

l Reporting Period

l Rate

Billing Summary
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

The Billing Summary report can summarizemultiple bills in one report and allows run-time
customization of exactly what is calculated and displayed in the report. With the Billing Summary
report, you can generate a bill for multiple tenants (sources) with a common rate file. The report also
allows you to filter the tenants and the line items so you can show only the information you want in
the report.

NOTE: The Tenant (Source) input uses Hierarchy Views (for example, Physical Layout, Virtual
Meter). A hierarchy is required for the Billing Summary report to run.
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Report inputs:

l Title

l Tenant

l Reporting Period

l Rate

l Tenant Filter

l Line Item Filter

l Save Billing Totals

l Keep True Totals

Calendar Trend Month
Use the Calendar TrendMonth report definition to provide amonthly interpretation of out-of-hours
usage, benchmark performance targets, and to identify peak and off-peak usage patterns.

Report inputs:

l Title

l Single Source – see Sources (Devices and Views)

l Measurement – seeMeasurements (with Smart Mode)

l Start Hour

l EndHour

l Highlight Start

l Highlight End

l Reporting Period

l Target Line

l Source Label

l Display Zero Days

l Auto-scale Y-Axis

l Include DataWarnings.

Calendar Trend Week
Use the Calendar TrendWeek report definition to provide a weekly interpretation of out-of-hours
usage, benchmark performance targets, and to identify peak and off-peak usage patterns.

Report inputs:

l Title

l Single Source – see Sources (Devices and Views)

l Measurement – seeMeasurements (with Smart Mode)

l Start Hour

l EndHour



l Highlight Start

l Highlight End

l Reporting Period

l Target Line

l Source Label

l Auto-scale Y-Axis

l Include DataWarnings.

Circuit Breaker Aging
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

This report allows you tomonitor and report on the status of circuit breaker aging and wear of the
devices in your electrical system.

Report inputs:

l Title

l Select Group

l Grouped By

l Include Breakers with Minor Aging andWear

l Include DataWarnings

Consumption Ranking
Use the Consumption Ranking report definition to visualize the relative ranking of energy
consumption for one or more source/measurement pairs. You can normalize the consumption data
to facilitate your comparison. This report is intended to assist you in building energy awareness
through relative visualization.

Report inputs:

l Title

l Select Sources – see Sources (Devices and Views)

l Select Measurement – seeMeasurements (with Smart Mode)

l Multiplier

l Scale Source

l ScaleMeasurement

l Reporting Period

l Gauge Scale Override

l Select

l Select Number

l Custom Units Label
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l Source Label

l Include Chart

l IncludeGauges

l Include Tables

l Auto-scale Y-Axis

l Include DataWarnings.

Data Export - Extended
Use the Data Export - Extended report definition to create a CSV file containing the data for the
selected sources andmeasurements. When the CSV file is generated, you are prompted to save
the file in a location of your choice.

The data is organized in columns labeled Timestamp UTC, Timestamp, Value, Source,
Measurement, andUnit. This organization facilitates the creation of an Excel pivot table for
analyzing the data in the file.

The data is listed for each source andmeasurement by date and in time the specified time
segments for the data.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Reporting Period

l Include Duplicates

Data Export - Standard
Use the Data Export - Standard report definition to create a CSV file containing the data for the
selected sources andmeasurements. When the CSV file is generated, you are prompted to save
the file in a location of your choice.

The Data Export - Standard report exports more data to the CSV file because of the way it is
organized. For example, where it can export 600 sourcemeasurements for 11months, the Data
Export - Extended report can export 80 sourcemeasurements for 10months.

The data is organized by column, with column A labeled Timestamp. The remaining columns are
labeled with the source name andmeasurement. The data is listed by date and in the specified time
segments for the data.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Reporting Period

l Include Duplicates



Duration Curve
Use the Duration Curve report definition to determine how to reduce peak demand and to lower base
load, to validate performance characteristics and to perform capacity modeling tasks.

Report inputs:

l Title

l Single Source – see Sources (Devices and Views)

l Measurement – seeMeasurements (with Smart Mode)

l n% Crossing

l Exclude Values Over

l Exclude Values Under

l Reporting Period

l Target Line

l Source Label

l Auto-scale Y-Axis

l Include Data Table

l Include DataWarnings.

EN50160:2000
EN50160:2000 is a set of power quality standards used by certain energy suppliers and energy
consumers. There are two default report definitions available: EN50160:2000 and EN50160:2000
Mains Signaling.

The EN50160:2000 report definitions use the following types of data from devices: supply voltage
dips; temporary overvoltages; supply voltage unbalance; harmonic voltage; interharmonic voltage;
frequency andmagnitude; flicker; and short- and long-term interruptions.

EN50160:2000

Use the EN50160:2000 report definition to create a report containing comprehensive analysis of all
EN50160 2000 compliance data logged by multiple meters. The compliance summary is based on
the EN50160 2000 limits for each observation period: each default EN50160measurement
indicates a pass or did not pass on the compliance test with a Y (yes) or N (no) respectively.

Report inputs:

l Title

l Sources

l Evaluation Limits

l Reporting Period

l Include EN50160 Configuration Parameters

l Include DataWarnings

l Source Label
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EN50160:2000 Mains Signaling

Use the EN50160:2000Mains Signaling report definition to create a report for signal line frequency
statistics for multiple sources, for each observation period.

Report inputs:

l Title

l Sources

l Signaling Voltage

l Reporting Period

l Include DataWarnings

l Source Label

EN50160:2010
EN50160:2010 is a set of power quality standards, published in 2010, used by certain energy
suppliers and energy consumers. There are two default report definitions available: EN50160:2010
and EN50160:2010Mains Signaling.

The EN50160:2010 report definitions use the following types of data from devices: supply voltage
dips; temporary overvoltages; supply voltage unbalance; harmonic voltage; interharmonic voltage;
frequency andmagnitude; flicker; and short- and long-term interruptions.

EN50160:2010

Use the EN50160:2010 report definition to create a report containing comprehensive analysis of all
EN50160 2010 compliance data logged by multiple meters. The compliance summary is based on
the EN50160 2010 limits for each observation period: each default EN50160measurement
indicates a pass or did not pass on the compliance test with a Y (yes) or N (no) respectively.

Report inputs:

l Title

l Sources

l Evaluation Limits

l Reporting Period

l Include EN50160 Configuration Parameters

l Include DataWarnings

EN50160:2010 Mains Signaling

Use the EN50160:2010Mains Signaling report definition to create a report for signal line frequency
statistics for multiple sources, for each observation period.

Report inputs:

l Title

l Sources

l Signaling Voltage



l Reporting Period

l Include DataWarnings

Energy Comparison
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

The Energy Comparison report allows the comparison of different load types on a particular source.
The comparison is instrumental when you perform building benchmarking. This report converts
energy to a common energy unit and can normalize energy by criteria, such as area. Results are
shownwith either bar or pie charts.

Report inputs:

l Title

l Energy Measurements

l Energy Measurement Label

l Rollup

l Reporting Period

l Show Start & End Periods Only

l Chart Type

l Auto-scale Y-Axis

l Include Data Table

l Include DataWarnings

Energy Cost
Use the Energy Cost report definition to create a report on energy consumption and peak demand
levels over a period of time, categorized by time of use. The Energy Cost report definition uses
energy and demandmeasurements.

With an Energy Cost report, you can:

l Use a time of use (TOU) schedule that you define using the Time of Use Editor (see the "Time of
Use Editor" topic in theManagement Console Tools section of the onlinePowerMonitoring
Expert Help).

or

l You can set a flat rate on theEnergy and Demand tab of theEnergy Rates dialog. See Rates
for more information.

NOTE: This report is intended to be used for positive power flow applications only (where kW and
kVAR are both positive). Use with bi-directional flow gives incorrect results.

Report inputs:

l Title

l Sources
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l Rates

l Reporting Period

l Include DataWarnings

l Source Label

Energy Period over Period
Use the Energy Period over Period report definition to create a report that compares ameasurement
frommultiple devices over specified time periods (for example, this week vs. the sameweek from
the previous month).

Report inputs:

l Title

l Sources

l Measurement

l Report Period (with additional options)

l Auto-scale Y-Axis

l Include Aggregation Chart

l Include Stacked Aggregation Chart

l Include Interval Line Trend

l Include Interval Column Trend

l Source Label

l Include Data Table

l Include DataWarnings.

Energy Regression Analysis
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

This report shows modeled energy analysis data with respect to a particular data driver, such as
weather.

Report inputs:

l Title

l Driver Data Source

l Driver Data Quantity

l Model Data Source

l Model Data Quantity

l Reporting Period

l Regression Type

l X Axis CalculationMethod



l Degree Days Pivot Point

l Y Axis CalculationMethod

l Aggregation Interval

l Exclude IncompleteWeeks

l Exclude Incomplete Days

l Exclude Days with Rollover

l Deviation Type

l Max Authorized Deviation

l Include DataWarnings

l Include Report Parameters Summary

Energy Usage
Use the Energy Usage report definition to create a report highlighting discrepancies and providing a
visual interpretation of the data using the available display options.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Reporting Period

l Aggregation Interval

l Start Hour

l EndHour

l Lower Target Line

l Upper Target Line

l Source Label

l Include ColumnChart

l Include Stacked ColumnChart

l Include Line Chart

l Include Pie Chart

l Include 100% Area Chart

l Include Area Chart

l IncludeGauges

l Auto-scale Y-Axis

l Include DataWarnings.
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Energy Usage by Shift
Use the Energy Usage by Shift report definition to create a report that compares ameasurement
frommultiple devices for specified time periods (or shifts). This allows you to compare energy
usage between shifts (for example, 6:00-1:00 vs. 1:00 to 8:00).

NOTE: If you generate a report before the end of a shift that spans midnight, a portion of the usage
data for that shift is included under the equivalent shift for the current day.

For example, assume:

1. You specify three 8-hour shifts:

Shift 1: 7:00 AM to 3:00 PM

Shift 2: 3:00 PM to 11:00 PM

Shift 3: 11:00 PM to 7:00 AM

Note that Shift 3 spans midnight (12:00 a.m.).

2. YourReporting Period is Last 7 Days.

3. You generate the report on day 8 before 7:00 a.m., that is, before the end of Shift
3 for day 7.

The generated report will include usage data under Shift 3 for day 8. However, this
shift 3 usage data is that portion of shift 3 from the previous day (day 7) that occurred
after midnight.

In addition, this allocation of usage data to the next day for shift 3 frommidnight to
7:00 a.m. occurs for all of the days throughout the reporting period.

To avoid this situation, select specific days (Fixed Date) for theReporting Period.

Report inputs:

l Title

l Sources

l Measurement

l Reporting Period

l Aggregation Interval

l Shifts

l Include DataWarnings

l Source Label

Energy Usage by TOU
Use the Energy Usage by TOU report definition to generate a report showing energy usage
associated with time of use schedule periods.

Report inputs:

l Title

l Sources (Devices and Views)



l Measurements (with Smart Mode)

l Reporting Period

l Aggregation Interval

l Select Time of Use

l Lower Target Line

l Upper Target Line

l Source Target Line

l Measurement Target Line

l Chart Type

l Source Label

l Include Data Tables

l Auto-scale Y-Axis

l Include DataWarnings.

Event History
Use the Event History report definition to create a report of events or alarms that have occurred in
the system. It includes the following information for each event: timestamp; source name; event
description; and event priority.

If no event has occurred that matches the inputs entered when generating the report, no data is
returned.

Report inputs:

l Title

l Sources

l Reporting Period

l Include DataWarnings

l Priority

l Source Label

Harmonic Compliance
Use the Harmonic Compliance report definition to generate a report showing an analysis of the
harmonic compliance of selected sources based on the IEEE 519-1992 reference limits. Consult
IEEE 519-1992 standards documentation for details about harmonic limits.

Report inputs:

l Title

l Sources (Devices and Views)

l Reporting Period

l Comments
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l Include THD/TDD Charts

l Include Average Harmonic Charts

l Include Harmonic Detail Charts

l Lock Chart Scales at Zero

l Include DataWarnings

Hourly Usage
Use the Hourly Usage report definition to create a tabular report to display usage of various types of
quantities (such as consumption of Water, Natural Gas, and so on) per hour for a specific day.

A single report may contain consumption figures for different types of measurements frommore
than one source.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Reporting Period

l Target Line

l Source Label

l Include Data Table

l Include Chart

l Auto-scale Y-Axis

l Include DataWarnings.

IEC61000-4-30
Use the IEC61000-4-30 report definition to create a report on IEC61000-4-30 compliance
information by observation period (a 3 second, 10minute, or 2 hour measurement interval) for one or
more sources.

The IEC61000-4-30 report definition provides the following types of information: voltage profile;
THD profile; unbalance profile; flicker profile; frequency profile; and summary table.

Report inputs:

l Title

l Sources

l Measurement Interval

l Voltage Nominal [V]

l Frequency Nominal [Hz]

l Voltage Baseline [%]

l THD Baseline [%]



l Frequency Baseline [%]

l Unbalance Baseline [%]

l Flicker Baseline - High

l Flicker Baseline - Low

l Reporting Period

l Source Label

l Include DataWarnings

Load Profile
Use the Load Profile report definition to create a graphical representation of demand or load levels
over a period of time. The profile shows peak loads as points on the graph where peak electricity
demand is high. A load trend report can be used to analyze the electrical loads at the time of
maximum demand. This information can show opportunities for developing strategies to improve
energy management.

The Load Profile report definition uses similar measurements as the Energy Cost report definition
but does not use a TOU schedule.

Report inputs:

l Title

l Sources

l Measurements

l Reporting Period

l Include Data Table

l Auto-scale Y-Axis

l Target Line (kW)

l Target Line (kVAr)

l Target Line (kVA)

l Source Label

l Include DataWarnings

Multi Device Usage
Use theMulti Device Usage report definition to view consumption information for multiple devices.
View energy usage for a single period, or compare two periods, for example, this month versus last
month.

NOTE: Themeasurements that you select for the devices need to provide equivalent data results.
For example:

l Correct:

Real Energy selected for MeterA
Real Energy into the Load selected for MeterB
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l Incorrect:

Real Energy selected for MeterA
Reactive Energy selected for MeterA

The report provides a summary of consumption by one or more sources, an interval usage table, and
a pie chart.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Aggregation Interval

l Reporting Period

l Include Two Specific Periods Only

l Source Label

l Chart Type

l Auto-scale Y-Axis

l Include Data Table

l Include DataWarnings

Multiple Billing
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.

TheMultiple Billing report extends the existing BillingModule report to allow the selection of Multiple
Tenants. By allowingmultiple Tenant selection you can create, save and schedule one report for all
tenants on a commonRate. To do so, select your Tenant(s) and configure the rest of the report
parameters as usual.

The output of this report is a single file, so if you choose to save or subscribe to a pdf file, then each
bill appears on its own page for easy printing, etc.

Report inputs:

l Title

l Tenant

l Reporting Period

l Rate

l Save Billing Totals

l Notes

Multiple Billing Export
NOTE: For most products, the availability of this report is subject to licensing. Contact your
Schneider Electric representative for more information.



TheMultiple Billing Export report exports tenant billing data automatically in a customized format for
easy integration with third-party billing systems. The report generates a bill for the tenants for the
specified date range with the selected billing rate.

Use theMultiple Billing report to generate billing data for multiple tenants (sources) with a common
rate file. The report also allows you to filter the tenants and the line items so you can show only the
information you wish in the report.

NOTE: The Tenant (Source) input uses Hierarchy Views (for example, Physical Layout, Virtual
Meter). A hierarchy is required for theMultiple Billing Export report to run.

Report inputs:

l Title

l Tenant

l Reporting Period

l Rate

l XML Transform File

l XMLExport File

l Overwrite XML Export

l Stylesheet (optional)

l Save Billing Totals

l Email XML Export

l Email Recipients (comma separated)

Multiple Trend
Use theMultiple Trend report definition to create a report showingmultiple measurements plotted on
separate axes.

Report inputs:

l Title

l Left and Right Axis Sources – see Sources (Devices and Views)

l Left and Right Axis Measurements – seeMeasurements (with Smart Mode)

l Left Axis High Target Line and Right Axis High Target Line

l Left Axis High Target Name and Right Axis High Target Name

l Left Axis Low Target Line and Right Axis Low Target Line

l Left Axis Low Target Name and Right Axis Low Target Name

l Reporting Period

l Chart Type

l Source Label

l Include Data Table
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l Auto-scale Y-Axis

l Include DataWarnings

Power Quality
Use the Power Quality report definition to create a report that summarizes the number and severity
of voltage sags, swells, and transients over a period of time. The finished report also includes a
graphical representation of the disturbances plotted on a CBEMA-ITIC curve.

The Power Quality report aggregates historical PQ (Power Quality) data into power quality
incidents. An incident is a summary, or aggregated event, which represents a number of individual
events (sags, swells, or transients) that occurred across an electrical network in a small window of
time. Disturbance refers to a sag, swell, or transient event in the Event Log, while incident refers to
a group of (1 or more) disturbances.

Report inputs:

l Title

l Sources

l Incident Interval

l Reporting Period

l Source Label

l Include DataWarnings

The generated report displays:

l A summary of incidents, incident interval, and number of disturbances.

l The details of the worst disturbances for each power quality incident in the report.

l Statistics for each power quality incident in the report (for example, first timestamp, duration, and
the number of transients, sags and swells within the incident).

From the report, you can view either details for an incident or waveform details.

PQ Incident Detail

To view details of an incident, click the incident in the First Timestamp column of theStatistics
table.

Detailed information about a single power quality incident is displayed, including:

l A CBEMA plot containing the power quality disturbances for the selected incident.

l The timestamps, types, durations, phases andmagnitudes of disturbances in the selected incid-
ent, with the worst event in the selected incident highlighted (worst event = largest magnitude x
duration).

l The power quality settings of the device that registered the disturbance (for example, sag/swell
limits, transient threshold, and so on).

To return to the PQSummary report, use the browser’s back button.

PQ Waveform Detail

To view the waveform details of an incident, click the waveform icon for the incident.



The waveform details present all of the waveforms that were recorded for a disturbance. It displays
a waveform chart along with an optional table with waveform values.

The following waveform plots and data are displayed, based on the timestamp selected:

l A summary waveform plot, displaying a plot of the V1, V2 and V3waveforms.

l An individual waveform plot for each of:

V1 and I1

V2 and I2

V3 and I3

l If the source queried has digital input logging enabled over the time interval of the waveforms, a
waveform showing the digital input status.

l The timestamp for the time the waveforms were triggered.

l The sampling frequency of the waveforms.

To return to the PQSummary report, use the report section back button on the report toolbar.

Single Device Usage
Use the Single Device Usage report definition to view energy information for one device. View
energy usage for a single period, or compare two periods, for example, this month versus last
month.

The report provides a summary of the various usage periods, an interval usage table, and a
graphical comparison of the various usage periods.

Report inputs:

l Title

l Single Source – see Sources (Devices and Views)

l Measurements (with Smart Mode)

l Aggregation Interval

l Reporting Period

l Source Label

l Include Two Specific Periods Only

l Align Day of Week for Months

l Auto-scale Y-Axis

l Include DataWarnings
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System Configuration
Use the System Configuration report definition to create a report containing details about devices in
your network, including: device names and types; communications information (such as, IP
address, unit ID, protocol) for devices; sites to which devices belong; status of sites (offline or
online); and descriptions of the devices in the system (if a description was entered inManagement
Console).

This report is useful to Network Administrators when checking network performance and for
planning network growth.

Report inputs:

l Title

l Include DataWarnings.

Tabular
Use the Tabular report definition to create a report of data in a tabular format. You can create a report
with multiple measurements frommultiple sources. You can also select the option to include
duplicate data in the report. This data can then be exported for use in another program, such as
Microsoft Excel. If you want to only export your data to an Excel file, use the Data Export -
Extended report or the Data Export - Standard report.

NOTE: The Tabular Report is limited to 30 source-measurement pairs. Multiple reports are required
if the number of source-measurement pairs exceeds 30.

The generated report contains the following information: source; measurement; timestamp; and
values.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Reporting Period

l Source Label

l Include Duplicates

l Include DataWarnings

Trend
Use the Trend report definition to create a report that displays trend information in a line, column,
bar, or pie chart. You select devices andmeasurements for a selected period of time.

NOTE: The Trend Report is limited to 30 source-measurement pairs. Multiple reports are required if
the number of source-measurement pairs exceeds 30.

NOTE: The Trend Report has been upgraded in PowerMonitoring Expert 7.2.1 to include two new
parameters: Include Data Table and Include Duplicates. Trend Reports with subscriptions
created prior to version 7.2.1 need to be updated and saved with the new parameters.



l Open each saved Trend Report. The new parameters are visible in the display pane.

l Keep or change the default selections for the parameters.

l Save the updated report to overwrite the existing version.

This ensures that subscriptions for Trend Reports continue to function.

Report inputs:

l Title

l Sources (Devices and Views)

l Measurements (with Smart Mode)

l Chart Type

l Reporting Period

l Source Label

l Target Line

l Auto-scale Y-Axis

l Include Data Table

l Include Duplicates

l Include DataWarnings.

Report input parameters
The report input area opens when you select a report in theReport Library. Youmust specify the
necessary input parameters before you can generate the report. For saved reports, some or all of the
input parameters may already be specified.

After you generate a report, you can display or change the input parameters you specified for it by
clicking show inputs in the top-right corner of the report display area. To return to the generated
report without changing any of the input parameters, click hide inputs. If you change any of the
input parameters, click Generate Report to regenerate the report.

Inputs for default report definitions
The following information describes the inputs for the default report definitions. The available inputs
vary by report definition listed in theReports Library.

Aggregation Interval

This input determines the period of time over which data is accumulated for presentation in the
report, such as day, week, and so on. From the dropdown list, select the aggregation interval that
you want to use. If a custom report includes a predefined aggregation interval, contact the owner to
adjust the interval for your use.

Align Day of Week for Months

When the Aggregation Interval is Month, selectingYes includes the data in the table by day of week
(Sun, Mon, Tues, and so on). SelectingNo includes the data in the table by the day of themonth (1,
2, 3, and so on). The default is Yes.
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Auto-scale Y-Axis

Select whether or not to scale the chart normally. SelectingNo sets the starting point of the Y-axis
at zero. The default is Yes.

Chart Type

Select one of the available chart types from the dropdown list to graphically display the data that you
specified for the report.

Comments

Use this field to add comments that will appear at the bottom of the generated report.

Custom Units Label

Enter any text to be used as themeasurement label for instances when normalization is used , for
example, kWh/Person. The default is kWh.

Degree Days Pivot Point

The Degree Days Pivot Point is the point where either heating or cooling is required to keep the
temperature within the designated degree range.

Deviation Type

Enter a percentage or specific value to specify the the type of deviation to show in the report.

Display Zero Days

Select whether or not to show days where data is logged but the values are all zero. Note that days
with no logged values at all are still included in the report. The default is No.

Driver Data Quantity

Click Select Measurement. Navigate to and select ameasurement, and then click OK.

Driver Data Source

Click Select Source, and then choose from the dropdown list a Grouping: None, Group Name, Site,
or Device Type. Navigate to and select a source, and then click OK.

Email Recipients (comma separated)

A comma-separated list of email addresses to which to email the transformed XML.

Email XML Export

Select Yes to email the transformed XML output ('XML Export File') to the addresses specified in
Email Recipients.

End Hour

Select the end hour to display when filtering the data by the time of day.

The time range in the list is in 24-hour format in descending order.

Energy Measurement Label

Input the label to be used to describe themeasurements selected in Energy Measurements.

Energy Measurements

Select the load group and load source you want.



Evaluation Limits

Click Configure to configure the EN50160 parameters used in the report. Default values are
provided based on the EN50160 standard.

Click the links in the dialog box to access configuration options for various measurements included
in the report:

l Basic Configuration: Type themaximum percentage of intervals in an observation period
where the component does not meet the EN50160 N1 and N2 requirements before the com-
ponent is considered non-compliant.

l Supply Voltage Dips: Type themaximum percentage of intervals in an observation period that
the RMS value can drop below 90% of the nominal voltage for each duration and depth presented
in the dialog box before the component is considered non-compliant.

l Short and Long Interruptions: Type themaximum percentage of intervals in an observation
period that the RMS value can be less than 1% of the nominal voltage for the given duration
before the component is considered non-compliant.

l Temporary Overvoltages: Type themaximum percentage of intervals in an observation period
that the RMS value can exceed the nominal voltage by eachmagnitude for each duration presen-
ted in the dialog box before the component is considered non-compliant.

NOTE: The EN50160 standard defines the observation period for the above components as one
week.

Event Priority

Select the priority of alarms and events that you want to include in the report. The options include
high, medium, and low priority alarms and events.

Exclude Days with Rollover

Exclude days that contain rollover from the report.

Exclude Incomplete Days

Exclude days that are incomplete from the report.

Exclude Incomplete Weeks

Exclude weeks that are incomplete from the report.

Exclude Values Over

Enter a value to indicate the point at which values over this number are not plotted in the chart. The
default value is No Exclusions.

Exclude Values Under

Enter a value to indicate the point at which values under this number are not plotted in the chart. The
default value is No Exclusions.

Flicker Baseline - High

Type the Flicker Baseline High value if the default is not appropriate for your needs.

Flicker Baseline - Low

Type the Flicker Baseline Low value if the default is not appropriate for your needs.
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Frequency Baseline [%]

Type the Frequency Baseline value if the default is not appropriate for your needs.

Frequency Nominal [Hz]

Type the nominal frequency of the system (for example, 60).

Gauge Scale Override

Choose a specific value for all of the gauge scales to use in custom situations, such as when
normalizing data. This input is optional.

Grouped By

Select from the dropdown list to determine how the circuit breaker aging and electrical wear analysis
results are sorted.

High Target Line (Left and Right Axis)

Enter a value for the target line representing the target for the high end of your energy use. This
target line is red in the generated report. The default is No Target Line.

High Target Name (Left and Right Axis)

Enter a name to identify the high target line in the chart legend for the left and right axis,
respectively. The defaults are Left Axis High Target andRight Axis High Target, respectively.

Highlight End

Select the end hour to stop the highlighting of the line in the chart.

The time range in the list is in 24-hour format in descending order.

Highlight Start

Select the start hour to begin the highlighting of the line in the chart.

The time range in the list is in 24-hour format in ascending order.

Incident Interval

Select the incident interval that you want to use in the report (such as, 20 seconds, 10minutes, 1
week).

Include Aggregation Chart

Select whether or not to include a bar chart in the generated report showing a summary of the
measurement you chose for the selected sources. The default is Yes.

Include 100% Area Chart

Select whether or not to include an area chart showing the data results stacked to a 100% level. The
default is Yes.

Include Area Chart

Select whether or not to include an area chart in the generated report to view the contribution of data
over a given period of time.



Include Average Harmonic Charts

Select whether or not to include charts showing the average values related to harmonic compliance.
The default is Yes.

Include Breakers with Minor Aging and Wear

Select Yes orNo. SelectingYes allows all of the breakers to appear in the report regardless of the
current electrical aging and electrical wear levels. SelectingNo allows only breakers with moderate
or critical electrical aging and electrical wear to appear.

Include Chart

Select whether or not to include the chart in the generated report. The default is Yes.

Include Column Chart

Select whether or not to include a column chart in the generated report to compare the data
represented in the chart. The default is Yes.

Include Data Table

Select whether or not to show the data table in the generated report. The default is No.

Include Data Warnings

Select whether or not to show data warnings in the generated report. The default is Yes.

Include Duplicates

Select whether or not to show duplicate data in the generated report. The default is No.

Duplicate data collection is disabled in PowerMonitoring Expert by default. To enable duplicate data
collection, the parameterSaveDuplicatesmust be set to 1 in the dbo.Registry table in the ION_
Data database. Contact your SQL Server administrator if you require this change. Also note that
enabling duplicate data collection results in more rapid growth in the size of the ION_Data database.

NOTICE
LOSS OF DATA

• Do not make unauthorized changes in the software product's databases.
• Only personnel with advanced knowledge of the software product's databases shouldmake
database parameter changes.

Failure to follow these instructions can result in irreversible database changes.

Include EN50160 Configuration Parameters

Select whether or not to include the configuration inputs entered in theConfigure Evaluation
Limits dialog in the generated report.

Include Gauges

Select whether or not to include the gauges in the generated report. The default is Yes.

Include Harmonic Detail Charts

Select whether or not to include charts showing a second level of harmonic compliance detail for the
generated report. The default is No.
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Include Interval Column Trend

Select whether or not to include a bar chart in the generated report showing themeasurement you
chose for the sources for each hour in the 24-hour period for the specified days. The default is Yes.

Include Interval Line Trend

Select whether or not to include a line chart in the generated report showing themeasurement you
chose for the sources for each hour in the 24-hour period for the specified days . The default is No.

Include Line Chart

Select whether or not to include a line chart in the generated report to display the data trend over a
given time period. The default is Yes.

Include Pie Chart

Select whether or not to include a pie chart in the generated report to show a numerical proportion of
the results. The default is Yes.

Include Report Parameters Summary

Select whether or not to include report parameters in the generated report. The default is Yes.

Include Stacked Aggregation Chart

Select whether or not to include a stacked chart in the generated report showing themeasurement
you chose for the selected sources. The default is No.

Include Stacked Column Chart

Select whether or not to include a stacked column chart in the generated report to display the
proportions for the data represented in the chart. The default is Yes.

Include Tables

Select whether or not to include the tables in the generated report. The default is Yes.

Include THD/TDD Charts

Select whether or not to include charts showing the total harmonic distortion (THD) of the voltage
waveform, and the total demand distortion (TDD) of the current waveform, in the generated report.
The default is Yes.

Include Two Specific Periods Only

Select whether or not to include only the first and last period of data in the selected date range. The
default is No.

Keep True Totals

Select Yes if you want the totals in the report to be unaffected by the filtering. If you want the totals
in the report to be based on line item and tenant filter, select No.

Line Item Filter

Anything entered in the Line Item Filter parameter (comma separated) excludes rows from the
Item column. For example, to exclude theOn Peak Usage line item, enterOn Peak Usage in the
Line Item Filter. To filter both On andOff Peak usage, enterPeak Usage.



Load Measurement

Select the source you want.

Lock Chart Scales at Zero

Select whether or not to force the y-axis to start at zero rather than scaling the chart normally. The
default is Yes.

Low Target Line (Left and Right Axis)

Enter a value for the target line representing the target for the low end of your energy use. This target
line is yellow in the generated report. The default is No Target Line.

Low Target Name (Left and Right Axis)

Enter a name to identify the low target line in the chart legend for the left and right axis, respectively.
The defaults are Left Axis Low Target andRight Axis Low Target, respectively.

Lower Target Line

Enter a value for the target line representing the target for the low end of the energy use. The lower
target is a yellow line in the report. Columns in charts that are on lower target line, or between the
lower target line and the upper target line, are outlined in yellow. The default value is 0.

Max Authorized Deviation

Enter a value by which deviation is allowed for the report.

Measurement Label

Input the label to be used to describe themeasurements selected in LoadMeasurement.

Measurements (Reports other than Load Profile)

Use this input to select themeasurements you want to include in the report.

Click Select Measurement to display theMeasurement Selector dialog. Click + and - to expand
and collapse items in the navigation tree. For reports where you can select multiple measurements,
click the check box beside ameasurement (or group of measurements) to select it. For reports
where you can only select a single measurement, click themeasurement name to select it.

After selecting themeasurements, click OK.

Measurements (with Smart Mode)
Smart Mode is enabled in theMeasurement Selectorwhen you select theViews radio button in
theSource Selector, which then lets you select a hierarchy view or a virtual meter for your source
parameter.

When you open theMeasurement Selector, Smart Mode lists general measurement names by
default. A Detailed Mode option is also available for themeasurements.

Smart Mode provides a general measurement name for you to select. Themeasurement is based
on a subset derived from all of the available measurements in the particular measurement category.
The underlying operation selects an applicable measurement for each device to produce equivalent
results for reporting purposes.
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The following image illustrates how measurements in Smart Mode are determined and applied from
the priority list of measurements. The priority list contains measurements that usually provide
equivalent results for themeasurement selected in Smart Mode.

For example, for each device included in a hierarchy view or in a virtual meter, the report starts with
the Real Energy measurement in the priority list. If data for that measurement exists, then it is used
in the report. If data does not exist for the Real Energy measurement, then the report goes to the
Real Energy Total measurement in the list. If data exists for that measurement, then it is used. The
report continues to progress through the priority list to select ameasurement that pertains to each
device associated with a hierarchy view or a virtual meter.

You can select Detailed to change to the detailed selectionmode. This mode allows you to select
from a full list of measurements.



Smart Mode Detailed Mode

TheMeasurement Selector provides a full list of measurements when you select theDevices
radio button in theSource Selector.

Click + and - to expand and collapse items in the navigation tree. For reports where you can select
multiple measurements, click the check box beside ameasurement (or group of measurements) to
select it. For reports where you can only select a single measurement, click themeasurement name
to select it.

After selecting themeasurements, click OK.

Measurements (Load Profile Report)

This input determines whether the report is calculated using demand or powermeasurements.
Select eitherDemand orPower from the dropdown list.

Measurement Interval

Select the observation period (that is, themeasurement interval) of 2 Hour, 10 Minute, or 3
Second to use for the IEC61000-4-30 report.

Measurement Target Line

Select ameasurement to use with the source identified inSource Target Line to establish ON and
OFF peak target lines in the generated report.

Model Data Quantity

Click Select Measurement. Navigate to and select ameasurement, and then click OK.

Model Data Source

Click Select Source, and then choose from the dropdown list a Grouping: None, Group Name, Site,
or Device Type. Navigate to and select a source, and then click OK.
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Multiplier

Enter a value to use as amuliplier in normalizing the raw data in the report. The default is 1.

n % Crossing

Type a value for the duration percentage. This value indicates where to place a cross on the plotted
line identifying where that percentage value occurs.

Notes

Any notes appear at the bottom of the report page.

Overwrite XML Export

SelectingYes overwrites an existing file if it exists, and selectingNo appends the new data to an
existing file.

Priority

Select the priority of alarms and events that you want to include in the report. The options include
high, medium, and low priority alarms and events.

Rate

Select the appropriate rate structure to apply to this report. The rate determines how the cost for
each tenant is calculated.

Rates
Use this input to set up parameters for energy cost reporting. Click Configure Rates to open the
Energy Rates dialog.

l Click Energy and Demand to configure basic rate parameters for the report.

In theSelect Measurements section, click the check box beside ameasurement to include
it in the report.

In theSelect Billing Calculation section, select Flat Rate or select TOU Schedule. If you
select TOU Schedule, select a time of use (TOU) schedule from the dropdown list (see the
Time of Use Editor topic in the online help for Management Console Tools for information on
configuring a time of use schedule).

In theSet Rates section, enter the rates for the selectedmeasurements.

In theSet Demand Calculation section, select the calculationmethod used to determine
demand: Independent (peak demand is calculated independently for each source) orCoin-
cident (the demandmeasurements of the sources are correlated with the peak demand of
themainmeter). If you select Coincident for the calculationmethod, click Main Meter to
select the source to which you want to correlate the demandmeasurements.

l ClickWAGES to includeWAGES (Water, Air, Gas, Electricity, Steam)measurements in the
report. Click the +/- buttons to add or removemeasurements. Enter a name for themeasurement
then click Select Source andSelect Measurement to select a source andmeasurement. Enter
a rate for themeasurement in theRate field.

l Click Additional Fees to add additional rate information to the report. Enter a name in theRate
Name field and rate information in theAmount field.



Regression Type

Choose from the dropdown list Single-Line or Broken-Line.

Reporting Period

Use this input to select the timeframe for the data you want to view in the report.

Select the reporting period from the dropdown list. The timeframe options in the timeframe dropdown
are relative to the date the report is run. To run a report that starts and ends in the past, select the
fixed date option. Type a start and end date in the date boxes or click the arrows beside the dates to
display a pop-up calendar and select a date. Type a time in the time boxes or click the up and down
arrows beside the time to adjust the hours or minutes up or down.

Select whether you want to view timestamps in either Server Local Time or UTC (Universal
Coordinated Time).

Reporting Period (with additional options)
The Reporting Period input contains the following fields and dropdown lists:

l Timezone: Select whether you want to view timestamps in either Server Local Time or UTC
(Universal Coordinated Time).

l Aggregation Period: Select the block of time for which you want to compare data (i.e., day,
week).

l Comparison Type: Select what period of data you want to compare the selected Aggregation
Period to (i.e., today vs. the same day from the previous month or current month vs. the same
month from the previous year). The options vary depending on the Aggregation Period selected.

l Number of Comparisons: Enter the number of periods you want to compare.

l Aggregation Interval: This input appears when you selectMonth for theAggregation Period.
Select how you want data grouped for the report: by date (Day of Month) or the day of the week.

l Selected Dates: This box displays the dates of the data that will appear in the report based on
the options selected.

For example, to compare the selectedmeasurements for the same day of themonth over the last 12
months, set Aggregation Period toDay, set Comparison Type to Today vs. Same Weekday
From Previous Month, and enter 12 in theNumber of Comparisons field.

Rollup

Select from the dropdown list the period of time for which the report data is rolled up.

Save Billing Totals

Save Billing Totals calculates the billing total per Tenant (Source) and writes the value back into
the database so that it can be used in other applications, such as Dashboards, Diagrams or
Reports.

Scale Measurement

Select themeasurement as the base against which to scale themain dataset. This input is optional.

Scale Source

Select the source as the base against which to scale themain dataset. This input is optional.
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Select

Select Top (highest result) orBottom (lowest result) to indicate the order of the gauges in the
generated report. The default is Top.

Select Group

Select a group from the dropdown list to be used for determining which switchboards and breakers
are used for the analysis.

Select Number

Enter the number of sources that you want to include in the ranking. The default is 99.

Select Time of Use

Select a TOU schedule to use for the report. Existing time of use schedules are referenced in the
list. If you have not created a time of use schedule, the field indicates that no time of use schedule
is available.

Shifts

Use the +/- buttons to add additional shifts. For each shift, enter a name and set the start and end
time for the shift.

To configure a shift that spans midnight, use two shifts with the same name. For example, to set up
a day shift and a night shift, add three shifts: Day from 8:00 AM to 8:00 PM, Night from 8:00 PM to
12:00 AM, andNight from 12:00 AM to 8:00 AM.

Show Report Parameters Summary

Select whether or not to show report parameters in the generated report. The default is Yes.

Show Start & End Periods Only

Select to show or not in the report the start and end periods. The default is No.

Signaling Voltage 1, 2 and 3 Eval Limit [%]

Type themaximum percentage of intervals in an observation period in which themean value of the
signaling voltage can exceed the curve defined in the EN50160 standard before that mains signaling
voltage is considered non-compliant.

Source Label
Select an option for the format of the label describing the source. The options areSource Name,
Source Description, andCombined Name/Description.

Sources

Use this input to select the devices you want to include in the report.

Click Select Sources to open theSource Selector dialog. From theGrouping list, select the way
in which you want to display the sources (for example by device type, by group name, and so on).
Click + and - to expand and collapse items in the navigation tree. Click the check box beside a
device (or group of devices) to select it. Click Select All orSelect None in the top-right corner to
select or clear all the check boxes.

After selecting the devices, click OK.



Sources (Devices and Views)

TheSource Selector dialog provides options to show Devices orViews:

Use theDevices option to select the devices you want to include in the report.

From theGrouping list, select the way in which you want to display the sources (for example by
device type or by group name). Click + and - to expand and collapse items in the navigation tree.
Click the check box beside a device (or group of devices) to select it. Click Select All orSelect
None in the top-right corner to select or clear all the check boxes.

After selecting the devices, click OK.

Use theViews option to select a hierarchy view (a tree of relationships) or virtual meters. The
hierarchy views and virtual meters are configured in the Hierarchy Manager component. (See the
Hierarchy Manager Help for further information about hierarchies, virtual meters, and views.) Click +
and - to expand and collapse items in the tree. Click the check box beside any hierarchy item in the
tree or any virtual meter to select it.

Click OK after making your selections.

Source Target Line

Select a source to use with themeasurement selected inMeasurement Target Line to establish
ON andOFF peak target lines in the generated report.

Start Hour

Select the start hour to display when filtering the data by the time of day.

The time range in the list is in 24-hour format in ascending order.

Stylesheet (optional)

Select the appropriate css stylesheet file to provide additional formatting to the billing data.

Target Line
Enter a value for the target line in relation to themeasurement you selected. The default value is not
to include a target line.

Target Line (kW)

Enter a value for the location of the target line in the kW chart in the generated report. The default is
0.

Target Line (kVAr)

Enter a value for the location of the target line in the kVAr chart in the generated report. The default
is 0.

Target Line (kVA)

Enter a value for the location of the target line in the kVA chart in the generated report. The default is
0.

Tenant

Selecting the tenant by device allows you to choose a source from a list of devices connected to
PowerMonitoring Expert. Selecting by view allows you to choose sources based on the views
configured in a hierarchy, such as a floor in a physical layout or a circuit in an electrical view, or by

WebApplications - Help Topics Reports

© 2015 Schneider Electric. All rights reserved. Page 113 of 124



Reports Web Applications - Help Topics

Page 114 of 124 © 2015 Schneider Electric. All rights reserved.

virtual meters defined in Hierarchy Manager. For additional information regarding hierarchies and
virtual meters, seeHierarchy Manager help.

Tenant Filter

Anything entered in the Tenant Filter parameter (comma separated) that matches any Billingmeta
data line items (Tenant column) is excluded. An '*' can be entered to include everything.

THD Baseline [%]

Type the THD Baseline value if the default percentage is not appropriate for your needs.

Title

Type a title for the report in the text box.

Unbalance Baseline [%]

Type theUnbalance Baseline value if the default percentage is not appropriate for your needs.

Upper Target Line

Enter a value for the target line representing the target for the high end of your energy use. The upper
target is a red line in the report. Columns in charts that on or above the upper target line are outlined
in red. The default value is 0.

Voltage Baseline [%]

Type theVoltage Baseline value if the default percentage is not appropriate for your needs.

Voltage Nominal [V]

Type the nominal voltage of the system (for example, 120).

X Axis Calculation Method

Choose from the dropdown list one of the followingmethods: Cooling Degree Days, Heating Degree
Days, Average, Sum, or Delta.

XML Export File

Select the name of the final XML output file, for example, MonthlyBillingDataMain.xml.

XML Transform File

Select the appropriate XML transform file that controls the format of the billing data export.

Y Axis Calculation Method

Choose from the dropdown list one of the followingmethods: Average, Sum, or Delta.

Generating and viewing a report
To generate a report from a report definition or from a report with some inputs saved:

1. Select the report definition in theReport Library.

2. Complete the required input parameters. (See Report input parameters.)

3. Click Generate Report. The report displays in the report display pane.

4. Click the forward and backward arrows at the top to navigate through the pages of the report (if
there aremultiple pages).



After you generate a report, you can display or change the inputs you specified for it by clicking
show inputs in the top-right corner of the report display area. To return to the generated report
without changing any of the inputs, click hide inputs. If you change any of the inputs, click
Generate Report to regenerate the report.

To generate a saved report (a report with some or all inputs defined and saved), select the report
from theReport Library. For reports with all inputs defined, the report is generated and displayed in
the report display pane. When you select a report with only some inputs specified, the report input
parameter area opens so that you can specify the remaining required parameters before you can
generate the report. (To see which parameters have been defined, click show saved inputs next to
the report name in the input parameter area.)

NOTE: Each report icon has a small circle on its lower right corner. If the circle is green, it is a
Defined Report—it has all of its inputs completed. If the circle is white, you need to fill in inputs
before you can generate it.

The date and time shown on the generated report is the server local date and time. To alter the
format of the date and time for a specific region, change the settings on theRegional Formatting
tab of theReporting Configuration Manager. Go toManagement Console and select Tools >
Reporting Configuration > Reporting Configuration Manager.

After you generate a report, you can do any of the following:

l Download the report as a PDF file, an Excel document, or a TIFF image file. See Downloading a
report.

l To enable subscriptions for the report, save the report with all of the inputs configured, then click
Manage in theReport Library to open theManage Reports dialog and select Subscribe. See
Creating report subscriptions.

l Click show inputs or hide inputs to show andmodify report inputs or to hide the report inputs,
respectively.

Downloading a report
You can download generated reports in the following formats:

PDF Creates a PDF of the report that you can view in Adobe Reader.

Excel
Creates a version of the report in Excel format that you can view
inMicrosoft Excel.

TIFF Creates a TIFF image file of the report.

To download a report:

1. Select the format you want from theDownload report as list at the top of the report display
area and select theOpen, Save, orCancel option in the pop-up.

2. Choose one of the following actions:

a. Click Open to open the report locally on your computer in the format you selected. This
requires that a compatible program for the format you selected exists on the computer.

b. Select Save to save the report on your computer in the format that you selected.

c. Select Cancel to exit the download process.
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If you download a report in PDF format, and the report has multiple columns of data in a wide table
(that is, if it has multiple measurements or multiple sources), the columns may appear onmultiple
pages in the file.

Saving a report
You can save a report before or after you generate it. In both cases, you need to specify all of the
input parameters for the report.

l If you intend to create a subscription for the report, you need to ensure that all of the input para-
meters are selected in theSave Report dialog before you save it.

l If you intend to generate the report manually rather than by subscription, you can select the input
parameters in theSave Report dialog that you want to save and specify the remaining
parameters when you select the report for generation.

For example, youmay always want to generate an Energy Cost report for a specific number of
devices for the previous month. When you save the report, you can save it with the inputs for the
devices and time period predefined.

To save a report:

1. Click a report definition in theReport Library pane to open it in the display pane.

2. Specify all of the input parameters required for the report.

3. If you do not want to generate the report, click theSave icon on theReport Library toolbar
to open theSave Report dialog, or click Generate Report and after the report has been
generated click theSave icon.

TheSave Report dialog opens.

4. Type a name for the report in theName field.

5. In the location box below theName field, select the location for the saved report or click New
Folder to create a new folder for it. (Note that you cannot nest one folder inside another.)

6. In the section at the bottom of the dialog, select show previously saved inputs and clear the
check boxes for the inputs that you do not want to save with the report.

When you generate one of these reports, you need to enter information for the inputs that were
not saved.

7. Click OK to save the report with the inputs you selected.

Report management, sharing, and subscriptions
TheManage Reports dialog provides options tomanage, share, and subscribe to reports.

Open the dialog by clicking theManage icon at the top of theReport Library pane. The
following options are available:

l Manage – create a new folder, delete or rename a folder or report, or move or copy a report from
one folder to another.

l Share –make a report available to a user or group.



l Subscribe – generate a report on a defined schedule or when system events or device alarms
occur, and distribute it via email or send to a file share or a printer.

Managing a report
Use theManage option in theManage Reports dialog to create a new folder, delete or rename a
folder or report, or move or copy a report from one folder to another.

1. Click the Manage icon in theReport Library and selectManage.

2. Select the report (or folder) that you want to manage.

3. Select one of these options:

a. New Folder: When theCreate New Folder dialog opens, type the name of the new folder
and click OK. The new folder appears in the list. (Note that you cannot nest one folder
inside another.)

b. Delete: A prompt appears asking you to confirm the deletion (unless you have selected an
empty folder—in this case the folder is deleted without confirmation). Click OK to delete the
report. If there are any subscriptions for the report, the prompt informs you of the sub-
scriptions.

c. Rename: Type the new name in the field at the bottom of the screen. Click Update to save
the change.

d. Copy: Select the location where you want to copy the report and click Update. The report
is copied to that location. The name of the copied report is “Copy of <report>”, where
<report> is the original report name.

e. Move: Select the new location and click Update. The report is moved to the new location.

Sharing a report
Use theShare option on theManage Reports dialog tomake a report available to a user or group.
Users with supervisor-level access can share any report; all other users can only share reports that
they own.

1. Click the Manage icon in theReport Library and select Share.

2. Select the report that you want to share from the list box.

3. Select the users or groups that you want to share the report with from theAvailable Users &
Groups box, then click the right arrow tomove the users or groups to theShare List.

To remove users or groups from theShare List, select the users or groups and click the left
arrow.

Select Order by type to order the lists alphabetically by group then by user.

4. Click Apply.

The report is available to the users in theShare List.

Subscribing to a report
A subscription is a report which is delivered in a specifiedmanner at a defined interval. For example,
a subscription can be configured so that a report is generatedmonthly and sent via email to a group
of people. It can also be generated and sent when a specified alarm condition occurs.
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Configuring subscription options
Before configuring certain types of subscriptions, you need to configure reporting subscription
options such as the SMTP server for email subscriptions or how to handle files when report
subscriptions are written to a fileshare. See the "Reporting ConfigurationManager" topic in the
Management Console Tools section of the onlinePowerMonitoring Expert Help for information
about configuring these options.

Adding a subscription

You can only create subscriptions for reports you have access to (see Sharing a report). The report
must be a saved report that has all of its inputs configured (see Report inputs and Saving a report).

1. To create report subscription:

a. Click theSubscribe icon on theReport Library toolbar, or

b. Click the Manage icon on theReport Library toolbar and select theSubscribe radio
control.

2. Select a report in the list and click Add to open theAdd New Subscription dialog.

3. Type a name for the subscription in theName field. This is the name that displays in the list of
subscriptions.

4. Select the output format.

5. Select a delivery mode:

Email: Click Distribution List. Enter the email addresses of the personnel that you want
to send the report to and click Add after each address. (Select an address from the list and
click Remove to remove it.) Click OK when the list is complete. In theAdd New Sub-
scription dialog, use theSubject field to type the text you want in the subject line of the
email.

File share: Type the location of the computer and folder where you want the report to be
saved. Youmust type the absolute pathname to the folder (including the drive letter). The
Windows user account “IONUser” must be configured with valid credentials to read and
write to that fileshare. See your system administrator for assistance. To overwrite an exist-
ing report (if one exists in the folder), select Overwrite existing file. To leave an existing
file in the folder and save the report with a new name, clearOverwrite existing file.

Printer: From the dropdown list, select the printer to which you want to send the report.

NOTE: For printed subscriptions, the printer must be a local printer on the Primary Server.
For information on setting a network printer as a local printer, consult your server's
documentation.

6. In theSubscription Schedule section, define the schedule on which you want the report to be
generated and delivered:

On Alarm: Select this option to configure the subscription to run on an alarm. Select the
event from the list that you want to use to trigger the subscription. To use this option, you
must first configure an Event Watcher. See theEvent Watcher topic in the online help for
Management Console Tools for information on creating an Event Watcher.



Once: Select this option to run the report once at the specified day and time. Use the arrow
beside theDate field to open a calendar where you can select the date. Type the time into
the Time of Day field or use the up/down arrows to change the hours andminutes.

Hourly: Select this option to run the report every hour. Select the time from the dropdown
list (for example, on the hour, 15minutes after the hour, and so on).

Daily: Select this option to run the report once per day at the specified time. Type the time
into the Time of Day field or use the up/down arrows to change the hours andminutes.

Weekly: Select this option to run the report once per week at the time and on the day of the
week that you specify. Select the day from the dropdown list. Type the time into the Time
of Day field or use the up/down arrows to change the hours andminutes.

Monthly — Monthly by Date: SelectMonthly then selectMonthly by Date to run the
report on selected dates in the calendar month at a specified time. Type the dates in theOn
calendar day(s) field. Separatemultiple dates with a comma. To select a range of con-
tinguous dates, separate the first and last date in the range with a hyphen. For example, to
schedule the report to run on the 1st, 10th to 15th, and 20th days of themonth, type 1, 10-
15, 20. After you have entered the dates, type the time into the Time of Day field or use the
up/down arrows to change the hours andminutes.

Monthly — Monthly by Day: SelectMonthly then selectMonthly by Day to run the
report on a specific day of the week in a selected week of themonth at a specified time. For
example, to set the subscription to run on theMonday of the last week of themonth, select
Last andMonday from the dropdown lists. Type the time into the Time of Day field or use
the up/down arrows to change the hours andminutes.

7. Click Test Now to test that the report subscription configuration is functioning.

8. Click Save to save the subscription.

The subscription appears in the list of subscriptions for the selected report.

Subscription errors and solutions

Certain messages may appear when you try to add subscriptions. For example, youmay not be
able to add the subscription in certain situations, or youmay be able to add it but the output is not
delivered successfully.

The following table summarizes possible messages, their cause, and suggested solutions.

Message Cause Solution

SQLAgent
service not
started

The SQL Server Agent
(ION) service is not running.
Subscriptions cannot be
delivered.

On the Primary Server, click Start > Settings >
Control Panel. Select Administrative Tools,
then select Services. Right-click the SQL
Server Agent (ION) service and select Start.

Report
Subscription
Service not
started

The ION Report
Subscription Service is not
running. Subscriptions
cannot be delivered.

On the Primary Server, click Start > Settings >
Control Panel. Select Administrative Tools,
then select Services. Right-click the ION
Report Subscription Service and select Start.

WebApplications - Help Topics Reports

© 2015 Schneider Electric. All rights reserved. Page 119 of 124



Reports Web Applications - Help Topics

Page 120 of 124 © 2015 Schneider Electric. All rights reserved.

Message Cause Solution

“From” email
address
incorrectly
configured

The email “from” address is
either not set or has an
incorrect configuration.

On the Primary Server, open the Reporting
Configuration dialog box inManagement
Console (Tools > Reporting Configuration).
Enter a valid email address. For example,
myemail@mycompany.com.

Path syntax
invalid

The file share pathname
entered is not correct.

Enter a valid UNC (Universal Naming
Convention) pathname.

Installing a report definition or a report pack
Report definitions and report packs can be developed by Schneider Electric or any other
organization skilled at developing content for Microsoft Reporting Services. To create report
definitions, report developers useMicrosoft Business Intelligence Development Studio, which can
be specified for installation with SQL Server.

A new report definition can be installed in the Reports application andmade available to users.
Users can generate and save reports based on the new report definition.

Report Definition versus Report Pack

For the purpose of installing report definitions and report packs, a report definition is a single .rdl file
whereas a report pack includes all files for a complex report or series of reports.

Installing or updating a Report Definition

1. On theWeb client computer click theUpload Report Template (Admin) icon in the
Report Library to open the Install Report Definition dialog.

2. Click Browse to navigate to the location of the .rdl file. Select the file, click Open, and then
click Install.

The uploaded report is located in ...\ PowerMonitoring Expert\web\ReportDepot\ION
Reports\ION Single Reports

3. Click New to open theNew Report From Definition dialog.

4. Click the new report name in the list, then click Next.

5. Click New Folder to open theCreate New Folder dialog.

6. Type a folder name and click OK to create the folder containing the new report in theReport
Library.

Installing or updating a Report Pack

1. Tomake a report pack available for upload from the server hosting theWeb Applications com-
ponent, copy it into the ReportPacks directory (located in ...\PowerMonitoring Exper-
t\web\ReportPacks\).

2. On the client computer click theUpload Report Pack (Admin) icon in theReport Library
to open theReport Pack Install dialog.

3. Select the report pack that you want to install and click Install.



For an existing report definition, a confirmationmessage indicates that all reports associated
with the definition are to be updated. Click OK to continue.

Creating a new report definition from a default report definition
You can create a new report definition by copying one of the existing default report definitions.

To create a new report definition:

1. Click theNew icon in theReport Library to open theNew Report from Definition dialog
listing all of the report definitions.

2. Select the report definition you want to base your new report on, and click Next.

3. Type a name for the new report in theName field. Select a location for the new report definition
from the navigation tree, or click New Folder to create a new folder.

4. Click Save to add the new report definition to the list of reports in theReport Library.

Creating custom report definitions
You can useMicrosoft Business Intelligence Development Studio to create custom report
definitions.

Custom report definitions should only be created by users with a thorough understanding of the
database access layer, Microsoft Business Intelligence Development Studio and Reporting
Services.

Contact your local Schneider Electric representative if you require specialized report definitions.

Report ownership and access
Access to a report is user-specific and can be assigned by a user with supervisor-level access or by
the owner of the report.

The owner of the report is the user who saved the report (see Saving a report).

To allow other users access to a saved report:

1. Click theManage icon to open theManage Reports dialog. Select Share to display the list of
reports and a list of available users and groups.

2. Click a report in the list, then click a user name in theAvailable Users & Groups list and use
the right-arrow tomove your selection to theShare List.

3. Click Apply to save your selection and continue working in theManage Reports dialog, or
click Close to save your selection and close the dialog.
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